
MODEL USER GUIDE

VIRTUA
L DESIG

N &



Information in this document is subject to change without notice. Companies, names and data used in
examples are fictitious.

Copyright ©2023 by InEight. All rights reserved. No part of this document may be reproduced or
transmitted in any form or by any means, electronic or mechanical, for any purpose, without the
express permission of InEight.

Microsoft Windows, Internet Explorer and Microsoft Excel are registered trademarks of Microsoft
Corporation.

Although InEight Model has undergone extensive testing, InEight makes no warranty or
representation, either express or implied, with respect to this software or documentation, its quality,
performance, merchantability, or fitness for purpose. As a result, this software and documentation are
licensed “as is”, and you, the licensee are assuming the entire risk as to its quality and performance. In
no event will InEight be liable for direct, indirect, special, incidental or consequential damages arising
out of the use or inability to use the software or documentation.

Page 2 of 490 InEight Inc.  |  Release 23.10

Release 23.10
Last Updated: 08 December 2023



InEight Inc.  |  Release 23.10 Page 3 of 490

CONTENTS
0.1 InEight Model Overview 21
0.1.1 Easily Share Models and Information 21

LESSON 1 — INSTALLATION 23
1.1 Installation 24
1.1.1 Steps 24
Install the InEight Model desktop application 24

1.2 Plugins 24
1.3 Launch Model 25
1.3.1 Model not integrated with InEight Platform 25
1.3.2 Model integrated with InEight Platform 25
1.3.3 Considerations 25

1.4 Model cache 26
1.4.1 Move cache to a new location 27
1.4.2 Considerations 27
1.4.3 Steps 27
Moving your existing InEightModel_Cache folder 27

Lesson 1 Review 28
Lesson 1 Summary 28

LESSON 2 — PROJECTS 29
2.1 Create a project 30

Create a project integrated with InEight Platform 30
Create a project not integrated with InEight Platform 30

2.2 Load a Project 31
2.2 Step by Step 1 — Load a Project 32

2.2.1 Manage sync 33
2.2.2 Remove projects from cache 34



2.3 Create a New Project from Template 35
2.3.1 Considerations 36
2.3.2 Steps 37
Create a New Project from Template 37

Lesson 2 Review 38

LESSON 3 — MODEL STREAMS 41
3.1 Model streams overview 41
3.2 Config Settings 42

3.2.0.1 Overview - Configuring Model Streams Parameters tab 47
3.2 Step by Step 1 — Config Settings - Parameters 48
3.2 Step by Step 2 — Config Settings - Scale / Rotate / XYZ 51
3.2 Step by Step 3 — Config Settings - Rename Model Stream 53
3.2 Step by Step 4 — Config Settings - Link to a different Model Stream 55

3.3 Export Settings 60
3.3.0.1 Export Settings options: 60

3.3.1 Steps 61
Export Settings 61

3.4 Model Revisions 63
3.4.0.1 Model with Same Name 63
3.4.0.2 Model with a Revised Name 64
3.4 Step by Step 1 — Resolve Model Conflict 65

3.5 Analyze Model Changes 67
3.5 Step by Step 1 — Analyze Model Changes 69

LESSON 4 — PROJECT STRUCTURE 73
4.1 Project Structure Overview 74
4.1.1 Project Structure Panel 74

4.2 Organize Model Streams 76
4.2 Step by Step 1 — Create Groups 76
4.2 Step by Step 2 — Delete Groups 80
4.2 Step by Step 3 — Creating a Model Stream Placeholder 82

4.3 Model Stream Management 84
4.3 Step by Step 1 — Change the Active Model Stream Revision 84
4.3 Step by Step 2 — Update Model Stream Revisions 87
4.3 Step by Step 3 — Disable Model Streams 87
4.3 Step by Step 4 — Remove Model Streams 88
4.3 Step by Step 5 — Adding Model Streams from Other Projects 90
4.3 Step by Step 6 — Publish a Model Stream into a Placeholder 92

Page 4 of 490 InEight Inc.  |  Release 23.10

Model User Guide



4.4 Model Stream Permissions 99
4.4 Step by Step 1 — Apply Permissions to Groups 100

Lesson 4 Review 103
Lesson 4 Summary 103

LESSON 5 — USER INTERFACE 105
5.1 Viewer Interface 106
5.1.1 Docking Panels: 107

5.2 Show Model Spots 111
5.2 Step by Step 1 — Show Model Spots 112

5.3 Navigation 113
5.3.0.1 First Person Navigation 116

5.4 Selection 117
5.4.0.1 Right Click Menu 123

5.5 Selection Mode 127
5.5.1 Selection Mode Indicator 128
5.5.2 Selection Mode - Last Object 128
5.5.3 Selection Mode - First Object 128
5.5.4 Selection Mode - IWP 129
5.5.5 Selection Mode - CWP 130
5.5.6 Selection Mode - Element 131
5.5.7 Selection Mode - Tag 132

5.6 Hot Keys 133
5.7 User Settings 143
5.7.1 Settings... 144
5.7.2 Mouse / Keyboard Mapping 144
5.7.3 Choose Default Zoom Behavior 145
5.7.4 Coordinate Display Units 146
5.7.5 Background Color 147
5.7.5.1 Choose Selection Display Style 148

5.7.6 Invert Scroll Wheel in First Person 148
5.8 Create New Markup 149
5.9 Grids 151

5.9 Step by Step 1 — Toggle on or off grids 152
Lesson 5 Review 153
Lesson 5 Summary 153

LESSON 6 — PROJECT UPDATES AND HISTORY 155
6.1 Command History 156
6.2 Project Updates 157

InEight Inc.  |  Release 23.10 Page 5 of 490

Model User Guide



6.3 Project History 159
Lesson 6 Review 163
Lesson 6 Summary 163

LESSON 7 — TAGS AND OBJECTS 165
7.1 Tags and Objects Overview 166
7.1.1 Tags and Objects Panel 166
7.1.1.1 Objects Tab 166
7.1 Step by Step 1 — Toggle Model Streams Visibility 169
7.1.1.2 Tags Tab 169

7.2 Create and Edit Tags 171
7.2.1 Manually Create and Edit Custom Tags 171
7.2 Step by Step 1 — Creating Tags 172

7.2.2 Delete a Tag 176
7.2 Step by Step 2 — Deleting Tags 177

7.3 Create and Edit Dynamic Tags 177
7.3 Step by Step 1 — Creating Dynamic Tags 178
7.3 Step by Step 2 — Editing a Dynamic Tag 183

7.4 Assign and Remove Tags 183
7.4.1 Assigning Tags 183
7.4 Step by Step 1 — Assigning Tags 183

7.4.2 Removing Tags 185
7.4 Step by Step 2 — Removing Tags 186

7.5 Copy Metadata from Model to Excel 186
7.5 Step by Step 1 — Copy Metadata from Model to Excel 187

7.6 Tag Data Exporter 188
7.6 Step by Step 1 — Export Tag Data to CSV file 188

7.7 Import Tags from Excel 195
7.7 Step by Step 1 — Import Tags from Excel 196

7.8 Select Model Objects Via Excel 201
7.8 Step by Step 1 — Select Model Objects via Excel 202

7.9 Create Tables of External Data 203
7.9.1 Identify the model Unique ID 203
7.9 Step by Step 1 — Identify the model Unique ID 204

7.9.2 Add information to Generic Table 208
7.9 Step by Step 2 — Add information to Generic Table 208

7.9.3 Import information to Generic Table 210
7.9 Step by Step 3 — Import information to Generic Table 210

7.9.4 Refresh existing table data 211

Page 6 of 490 InEight Inc.  |  Release 23.10

Model User Guide



7.9 Step by Step 4 — Refresh existing table data 212
7.9.5 Close Database Tables 212
7.9 Step by Step 5 — Close database tables 213

Lesson 7 Review 214
Lesson 7 Summary 214

LESSON 7 — DATA TRANSFORMATION OPERATIONS 215
7.1 Data Transformation Operations (DTO) Overview 215
7.1.1 DTO tab 216
7.1.2 Selector tab 217
7.1.3 Actions tab 218

7.2 Create a DTO 219
7.2.1 DTO Tab 219
7.2.1.1 Add a DTO Group Folder 219
7.2.1.2 Add a DTO 220
7.2.1.3 Rename a DTO 221

7.2.2 Selector Tab 221
7.2.3 Actions Tab 225

1.1 DTO Examples 227
1.2 Clean up and normalize model data 227
1.2.1 Group similar models into a tag 227
1.2.2 Convert dimensional text data into a number 230
1.2.3 Convert inches to feet 235
1.2.3.1 Convert text format to number format 235
1.2.3.2 Convert piping length from inches to feet 237

1.3 Identify and add additional model data 239
1.3.1 Identify model data 239
1.3.1.1 Identify and use AG/LB Piping 239
1.3.1.2 Identify and use AG/SB 241

1.3.2 Add weight to steel members using length 243
1.3.2.3 Convert weight from pounds to tons 245

1.4 Concatenate model data 246
1.4.1 Make unique tag values for multiple objects 246

1.5 Parse model data 249
1.5.1 Parse system information 249

1.6 Quantify model data 253
1.6.1 Extract quantities from model 254
1.6.1.1 Quantities by Count 254
1.6.1.2 Quantities by area 256
1.6.1.3 Quantities by volume 258

InEight Inc.  |  Release 23.10 Page 7 of 490

Model User Guide



1.6.1.4 Quantities by tag 260
1.6.1.5 Access quantities via Excel 262

1.7 Validate Model Data 263
1.7.1 Validate model data is compliant 263
1.7.1.1 Validate specific model data exists 263
1.7.1.2 Validate model data for specific format 265

LESSON 2 — STYLES 271
2.1 Styling Overview 272
2.1.1 Launch Styling Menu 272

2.2 Create and Manage Style Sets 273
2.2 Step by Step 1 — Create a Style Set 275
2.2 Step by Step 2 — Edit a Style Set 276
2.2 Step by Step 3 — Delete a Style Set 279

2.3 Create and Edit Styles 279
2.3 Step by Step 1 — Create a New Style 280
2.3 Step by Step 2 — Edit a Style 287
2.3 Step by Step 3 — Set a Style as a Default 288
2.3 Step by Step 4 — Delete a Style 289

2.4 Apply Styles to Tags 289
2.4 Step by Step 1 — Apply a Style to a Tag 290

2.5 Assign Styles Using Excel 292
2.5 Step by Step 1 — Color Excel Cells 293

2.6 Style Legend 297
Lesson 2 Review 300
Lesson 2 Summary 300

LESSON 3 — MASTER PRESETS 301
3.1 Master Presets Overview 302
3.1.1 Master Preset Editor 302
3.1.2 Reset Workspace 303
3.1.3 Right Click Menu Features 304

3.2 Create and Manage Master Presets 306
3.2 Step by Step 1 — Creating a Master Preset 306

3.2.1 Master preset object visibility maximum dialog box 307
3.2 Step by Step 2 — Editing a Master Preset 309
3.2 Step by Step 3 — Editing a Master Preset - Model View 310
3.2 Step by Step 4 — Deleting a Master Preset 312

3.3 Organize Master Presets 312

Page 8 of 490 InEight Inc.  |  Release 23.10

Model User Guide



3.3 Step by Step 1 — Grouping Master Presets 313
3.3 Step by Step 2 — Set a Master Preset as the Project Default 315

3.4 Share and Export Master Presets 316
3.4 Step by Step 1 — Sharing a Master Preset 317
3.4 Step by Step 2 — Exporting Master Presets 318

Lesson 3 Review 319
Lesson 3 Summary 319

LESSON 4 — COORDINATION - CLASH MANAGER 321
4.1 Clash Manager Overview 322
4.2 Create and Manage Coordination Rules 323
4.2.1 Considerations 323
4.2.2 Steps 323
Create a coordination rule 324
Edit a coordination rule 326
Export rules 328
Import rules 328

4.3 Tolerance Settings 329
4.3.1 Steps 330
Create rules for Expand, Sphere, and Cylinder tolerance settings 330

4.4 Create and Interrogate Clash Results 333
4.4.1 Considerations 333
4.4.2 Steps 334
Create clash results 334

4.5 Create and Manage Coordination Rule Groups 337
4.5.1 Considerations 337
4.5.2 Steps 337
Create a coordination rule group 338
Export rules groups 339

4.6 Show Duplicate Objects 340
4.6.0.1 Export duplicate objects 341

Lesson 4 Review 342
Lesson 4 Summary 342

LESSON 5 — COORDINATION - ISSUE MANAGER 343
5.1 Issue Manager Overview 344
5.2 Create and Manage Coordination Issues 345
5.2.1 Considerations 345
5.2.2 Steps 345
Add folders and sub-folders to organize issues 345

InEight Inc.  |  Release 23.10 Page 9 of 490

Model User Guide



Create a non-geometric clash issue 345
Create a coordination issue from clash results 346
Add markup 348
Edit an issue 348
Import issues 349
Export issues 350
Update issues 352
Delete a coordination issue 352

5.3 Coordination Issue Reporting 352
Access Issues via Excel Plugin for Reporting 353

Lesson 5 Review 356
Lesson 5 Summary 356

LESSON 6 — ARCHIVE 357
6.1 Archive Overview 358
6.1.1 Archive Library 360
6.1.1.1 Library Tab 360

6.2 Manage Documents 361
6.2 Step by Step 1 — Import Documents 361
6.2 Step by Step 2 — Download Documents 363
6.2 Step by Step 3 — Organize Documents 365
6.2 Step by Step 4 — Delete Documents or Folders 365
6.2 Step by Step 5 — Accessing Document Information 367
6.2 Step by Step 6 — Apply Permissions to Folders 368
6.2 Step by Step 7 — Search Documents 371

6.3 Create and Manage Labels 371
6.3 Step by Step 1 — Create and Apply a Label to a Document 371
6.3 Step by Step 2 — Apply an Existing Label to a Document 375
6.3 Step by Step 3 — Apply or Remove Labels within the Document Info
area 377

6.3 Step by Step 4 — Filter Documents by Labels 379
6.4 Link and Manage Docs to Tags 380

6.4 Step by Step 1 — Link Documents to Tags 381
6.4 Step by Step 2 — Associate a Specific Page within a PDF document
to a Tag 382

6.4 Step by Step 3 — View and/or Remove an Object Tag Link via the
Document Information Window 384

6.4 Step by Step 4 — View and/or Remove a Document Link via the
Selection Tab 385

Page 10 of 490 InEight Inc.  |  Release 23.10

Model User Guide



Lesson 6 Review 387
Lesson 6 Summary 387

LESSON 7 — SELECTION INFO 389
7.1 Selection Info Overview 390
7.1.1 Selection Information Panel 390
7.1.2 General Tab 391
7.1.3 Tags Tab 391
7.1.4 Style Tab 393
7.1.5 Documents Tab 394
7.1.6 Object Properties Tab 396
7.1.7 Linked Data 397
7.1.7.1 Selection Filter 398

Lesson 7 Review 400
Lesson 7 Summary 400

LESSON 8 — SECTIONING 401
8.1 Sectioning Overview 402
8.1.1 Sectioning Panel 402
8.1.2 Sectioning Icon 403

8.2 Create and Apply Sectioning 404
8.2 Step by Step 1 — Apply Sectioning Using the Set Box 404
8.2 Step by Step 2 — Apply Sectioning by Dragging and Dropping a Tag 406
8.2 Step by Step 3 — Apply Sectioning by the Offset 407
8.2 Step by Step 4 — Move Sectioning Panes with Grips 407
8.2 Step by Step 5 — Reset the Sectioning Box to Model Boundary 408
8.2 Step by Step 6 — Use Sectioning with Master Presets 409

Lesson 8 Review 411
Lesson 8 Summary 411

LESSON 9 — MEASUREMENTS 413
9.1 Measurements Overview 414
9.1.1 Measurement window 414

9.2 Apply and Manage Measurements 416
9.2 Step by Step 1 — Enter Measurement Mode 417
9.2 Step by Step 2 — Take a Measurement 417
9.2 Step by Step 3 — Delete a Measurement 421
9.2 Step by Step 4 — Clear Measurements 421
9.2 Step by Step 5 — Organize Measurements 422

Lesson 9 Review 426

InEight Inc.  |  Release 23.10 Page 11 of 490

Model User Guide



Lesson 9 Summary 426

LESSON 9 — MODEL EXPORTS 426
9.1 IFC Export 427

9.1 Step by Step 1 — IFC Export 427
9.2 OBJ Export 428

9.2 Step by Step 1 — OBJ Export 429

LESSON 9 — MODEL-BASED TAKEOFF 430
9.1 Model-based Takeoff Overview 431
9.1.1 Model and Estimate integration 431
9.1.2 Requirements for Model and Estimate integration 432

9.2 Model to Estimate integration 432
9.2 Step by Step 1 — Estimate to Model integration 432

9.2.1 Model integration configuration 433
9.2 Step by Step 2 — Run Model DTOs 434

9.2.2 Sync Model Quantities in Estimate 438
9.2 Step by Step 3 — Sync Model quantities 438

9.2.3 Select and frame Model objects 440
9.2 Step by Step 4 — Select and frame Model objects 440

9.2.4 User Defined Fields 441
9.2 Step by Step 5 — Rule setup UDF fields 12 and 13 442
9.2 Step by Step 6 — Rule setup UDF fields 12 through 15 443

LESSON 10 — ELEMENTS 445
10.1 Elements Overview 446
10.1.1 Elements Panel 446

10.2 Create and Manage Elements 448
10.2 Step by Step 1 — Create an element 449
10.2 Step by Step 2 — Create elements from a selection of objects 454
10.2 Step by Step 3 — Create elements from the tags 457
10.2 Step by Step 4 — Edit an element 457
10.2 Step by Step 5 — Unlink objects from an element 458
10.2 Step by Step 6 — Delete an element 459

Lesson 10 Review 460
Lesson 10 Summary 460

LESSON 10 — ADVANCED WORK PACKAGING & WORKFACE
PLANNING 461
10.1 Work Packaging Overview 461

Page 12 of 490 InEight Inc.  |  Release 23.10

Model User Guide



10.1.1 AWP Panel 462
10.2 Creating & Managing CWA, CWP & IWP 464

10.2 Step by Step 1 — Create a Construction Work Area (CWA) 465
10.2 Step by Step 2 — Create a Construction Work Package (CWP) 467
10.2 Step by Step 3 — Create a Installatoin Work Package (IWP) 470
10.2 Step by Step 4 — Deleting AWP Structure 472
10.2 Step by Step 5 — Filter AWP Structure 473

10.3 User management 473
10.4 User management 473

LESSON 10 — ADMIN TOOLS 474
10.1 Introduction 474
10.1.1 Browser compatibility 474

10.2 Login 474
10.2.1 Log-in Options 476
10.2.1.1 Username and Password Credentials 476
Reset password 476

10.2.1.2 SSO by Microsoft 477
10.2.1.3 SSO by Google 478

10.2.2 Switch account 478
10.3 Slide-out Panel 479
10.4 Projects 480
10.5 User Access Overview 482
10.6 User Account Management 483
10.6.1 Users & groups tab 484
10.6.1.1 Users 484
10.6.1.2 Create single sign-on or password user 485
Add user 486

10.6 Step by Step 1 — Add user 486
Edit user 487

10.6 Step by Step 2 — Edit user 487
Activate user 487
Deactivate user 487
Reset a user's password (SSO off) 487
Set a user's temporary password (SSO off) 487
Delete a pending user 487
Resend activation email (SSO off) 488

10.6.1.3 Groups 488
Add a group 488
Delete a group 488

InEight Inc.  |  Release 23.10 Page 13 of 490

Model User Guide



Rename a group 488
10.6.2 Project permissions tab 488
10.6.3 Export 490

Page 14 of 490 InEight Inc.  |  Release 23.10

Model User Guide



STEP-BY-STEP PROCEDURES
Install the InEight Model desktop application 24

Moving your existing InEightModel_Cache folder 27

Create a project integrated with InEight Platform 30

Create a project not integrated with InEight Platform 30

2.2 Step by Step 1 — Load a Project 32

Create a New Project from Template 37

3.2 Step by Step 1 — Config Settings - Parameters 48

3.2 Step by Step 2 — Config Settings - Scale / Rotate / XYZ 51

3.2 Step by Step 3 — Config Settings - Rename Model Stream 53

3.2 Step by Step 4 — Config Settings - Link to a different Model Stream 55

Export Settings 61

3.4 Step by Step 1 — Resolve Model Conflict 65

3.5 Step by Step 1 — Analyze Model Changes 69

4.2 Step by Step 1 — Create Groups 76

4.2 Step by Step 2 — Delete Groups 80

4.2 Step by Step 3 — Creating a Model Stream Placeholder 82

4.3 Step by Step 1 — Change the Active Model Stream Revision 84

4.3 Step by Step 2 — Update Model Stream Revisions 87

4.3 Step by Step 3 — Disable Model Streams 87

4.3 Step by Step 4 — Remove Model Streams 88

4.3 Step by Step 5 — Adding Model Streams from Other Projects 90

4.3 Step by Step 6 — Publish a Model Stream into a Placeholder 92

4.4 Step by Step 1 — Apply Permissions to Groups 100

5.2 Step by Step 1 — Show Model Spots 112

5.9 Step by Step 1 — Toggle on or off grids 152

7.1 Step by Step 1 — Toggle Model Streams Visibility 169

7.2 Step by Step 1 — Creating Tags 172

7.2 Step by Step 2 — Deleting Tags 177

InEight Inc.  |  Release 23.10 Page 15 of 490

Model User Guide



7.3 Step by Step 1 — Creating Dynamic Tags 178

7.3 Step by Step 2 — Editing a Dynamic Tag 183

7.4 Step by Step 1 — Assigning Tags 183

7.4 Step by Step 2 — Removing Tags 186

7.5 Step by Step 1 — Copy Metadata from Model to Excel 187

7.6 Step by Step 1 — Export Tag Data to CSV file 188

7.7 Step by Step 1 — Import Tags from Excel 196

7.8 Step by Step 1 — Select Model Objects via Excel 202

7.9 Step by Step 1 — Identify the model Unique ID 204

7.9 Step by Step 2 — Add information to Generic Table 208

7.9 Step by Step 3 — Import information to Generic Table 210

7.9 Step by Step 4 — Refresh existing table data 212

7.9 Step by Step 5 — Close database tables 213

2.2 Step by Step 1 — Create a Style Set 275

2.2 Step by Step 2 — Edit a Style Set 276

2.2 Step by Step 3 — Delete a Style Set 279

2.3 Step by Step 1 — Create a New Style 280

2.3 Step by Step 2 — Edit a Style 287

2.3 Step by Step 3 — Set a Style as a Default 288

2.3 Step by Step 4 — Delete a Style 289

2.4 Step by Step 1 — Apply a Style to a Tag 290

2.5 Step by Step 1 — Color Excel Cells 293

3.2 Step by Step 1 — Creating a Master Preset 306

3.2 Step by Step 2 — Editing a Master Preset 309

3.2 Step by Step 3 — Editing a Master Preset - Model View 310

3.2 Step by Step 4 — Deleting a Master Preset 312

3.3 Step by Step 1 — Grouping Master Presets 313

3.3 Step by Step 2 — Set a Master Preset as the Project Default 315

3.4 Step by Step 1 — Sharing a Master Preset 317

3.4 Step by Step 2 — Exporting Master Presets 318

Page 16 of 490 InEight Inc.  |  Release 23.10

Model User Guide



Create a coordination rule 324

Edit a coordination rule 326

Export rules 328

Import rules 328

Create rules for Expand, Sphere, and Cylinder tolerance settings 330

Create clash results 334

Create a coordination rule group 338

Export rules groups 339

Add folders and sub-folders to organize issues 345

Create a non-geometric clash issue 345

Create a coordination issue from clash results 346

Add markup 348

Edit an issue 348

Import issues 349

Export issues 350

Update issues 352

Delete a coordination issue 352

Access Issues via Excel Plugin for Reporting 353

6.2 Step by Step 1 — Import Documents 361

6.2 Step by Step 2 — Download Documents 363

6.2 Step by Step 3 — Organize Documents 365

6.2 Step by Step 4 — Delete Documents or Folders 365

6.2 Step by Step 5 — Accessing Document Information 367

6.2 Step by Step 6 — Apply Permissions to Folders 368

6.2 Step by Step 7 — Search Documents 371

6.3 Step by Step 1 — Create and Apply a Label to a Document 371

6.3 Step by Step 2 — Apply an Existing Label to a Document 375

6.3 Step by Step 3 — Apply or Remove Labels within the Document Info area 377

6.3 Step by Step 4 — Filter Documents by Labels 379

6.4 Step by Step 1 — Link Documents to Tags 381

InEight Inc.  |  Release 23.10 Page 17 of 490

Model User Guide



6.4 Step by Step 2 — Associate a Specific Page within a PDF document to a
Tag 382

6.4 Step by Step 3 — View and/or Remove an Object Tag Link via the
Document Information Window 384

6.4 Step by Step 4 — View and/or Remove a Document Link via the Selection
Tab 385

8.2 Step by Step 1 — Apply Sectioning Using the Set Box 404

8.2 Step by Step 2 — Apply Sectioning by Dragging and Dropping a Tag 406

8.2 Step by Step 3 — Apply Sectioning by the Offset 407

8.2 Step by Step 4 — Move Sectioning Panes with Grips 407

8.2 Step by Step 5 — Reset the Sectioning Box to Model Boundary 408

8.2 Step by Step 6 — Use Sectioning with Master Presets 409

9.2 Step by Step 1 — Enter Measurement Mode 417

9.2 Step by Step 2 — Take a Measurement 417

9.2 Step by Step 3 — Delete a Measurement 421

9.2 Step by Step 4 — Clear Measurements 421

9.2 Step by Step 5 — Organize Measurements 422

9.1 Step by Step 1 — IFC Export 427

9.2 Step by Step 1 — OBJ Export 429

9.2 Step by Step 1 — Estimate to Model integration 432

9.2 Step by Step 2 — Run Model DTOs 434

9.2 Step by Step 3 — Sync Model quantities 438

9.2 Step by Step 4 — Select and frame Model objects 440

9.2 Step by Step 5 — Rule setup UDF fields 12 and 13 442

9.2 Step by Step 6 — Rule setup UDF fields 12 through 15 443

10.2 Step by Step 1 — Create an element 449

10.2 Step by Step 2 — Create elements from a selection of objects 454

10.2 Step by Step 3 — Create elements from the tags 457

10.2 Step by Step 4 — Edit an element 457

10.2 Step by Step 5 — Unlink objects from an element 458

Page 18 of 490 InEight Inc.  |  Release 23.10

Model User Guide



10.2 Step by Step 6 — Delete an element 459

10.2 Step by Step 1 — Create a Construction Work Area (CWA) 465

10.2 Step by Step 2 — Create a Construction Work Package (CWP) 467

10.2 Step by Step 3 — Create a Installatoin Work Package (IWP) 470

10.2 Step by Step 4 — Deleting AWP Structure 472

10.2 Step by Step 5 — Filter AWP Structure 473

10.6 Step by Step 1 — Add user 486

10.6 Step by Step 2 — Edit user 487

InEight Inc.  |  Release 23.10 Page 19 of 490

Model User Guide



Page 20 of 490 InEight Inc.  |  Release 23.10

This page intentionally left blank.

Model User Guide



InEight Inc.  |  Release 23.10 Page 21 of 490

0.1 INEIGHT MODEL OVERVIEW

InEight Model is a platform for model and information aggregation that hides the complexity of
managing versions and sharing information across teams.

Import, contribute, modify, and recall models and information in a variety of ways. InEight Model
supports BIM to FM, coordination, field management, design renderings, visual scheduling, sensor
monitoring, and more. Collect and reuse data throughout the design, construction, and operations
phases without the current limitations of: managing file types, delays in uploading and downloading
files, version control, reentering data, and the difficulties of managing numerous point-solution
applications.

0.1.1 Easily Share Models and Information

When an internet connection is available, you are able to share models, information, documents, visual
styles, and much more with other users. We store your data on our servers and sync it to your local
hard drive whenever you’re online. Offline, your project data is kept in a central location on your
computer. When you're ready share, login and sync online. As teammates sync and share, you can
choose to view and interact with the information that only pertains to you
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LESSON 1 — INSTALLATION

Lesson Duration: 30 minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Install InEight Model
l Install plugins
l Launch InEight Model

Topics in this Lesson



1.1 INSTALLATION

InEight Model is cloud-hosted software with a Microsoft Windows-based application focused on 3D
model content. Model is not a model-authoring environment; rather, it provides the capability to
transform engineering and architectural models into construction and owner models.

The Model Windows application is supported by plug-ins and a locally stored cache folder
(InEightModel_Cache). Before you download and run the Model application on your desktop, review
the "Client System and Mobile Device Requirements Specification".

Local admin permissions are required to install InEight Model.

1.1.1 Steps

Install the InEight Model desktop application

1. Open https://ineight.com/ineight-software-downloads/ in your web browser.

2. Under InEight Model, selectModel Installer - Download to begin downloading the
InEightModel-64bit.exe file to your downloads folder.

3. After the download is complete, double-click the file to run the application.

1.2 PLUGINS

Model content is added to InEight Model either from an authoring application using plugins or through
IFC import. Each model imported to InEight Model is considered a Model Stream. The plugins listed
below are installed as part of Model Application installation and updated with Model application, with
the expection of the Excel plugin.

Excel plugin
(Windows)

Excel provides a means to add custom data into InEight Model and a
means for visual reporting.

Revit plugin
(Windows)

The Revit plugin provides a means for exporting models from Revit into
InEight Model.

AutoCAD plugin The AutoCAD plugin provides a means for exporting models from
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(Windows) AutoCAD into InEight Model.

Navisworks plugin
(Windows)

The Navisworks plugin provides a means for exporting models from
Navisworks into InEight Model.

IFC import
(Windows)

The IFC import provides a means for importing IFC (Industry Foundation
Class) type files into InEight Model.

1.3 LAUNCH MODEL

1.3.1 Model not integrated with InEight Platform

In Model (not integrated with Platform) you can create projects, user accounts, assign permissions, and
assign users to projects. When you create a new user, the user receives an email with login
information.

To launch Model, you can click the Model icon on your desktop or select Model from the Windows
Start menu. At the login screen, you can enter the login information provided in the email. You can also
sign in using single-sign-on (SSO).

After you sign in, the Load Project dialog window shows the projects that you have been assigned to.
Select a project to open.

InEight Model has online and offline capabilities which can be toggled at the login screen and within
the application. The best practice is to sign in online to ensure your local cache data is up to date with
the latest project information, and then use Model offline when needed.

1.3.2 Model integrated with InEight Platform

In Model (integrated with Platform) you can create projects, user accounts, and assign permissions.
When you create a new user, the user receives an email with SSO login information.

To launch Model, you can click the Model icon on your desktop or select Model from the Windows
Start menu. At the login dialog box, you can sign in using your SSO information provided in the email.

After you sign in, the Load Project dialog window shows all Model projects created in Platform.

1.3.3 Considerations

You must have administrative permissions
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1.4 MODEL CACHE

Model stores your project’s data in a local folder named cache. The cached project data is accessible
when you are offline. To use the project offline, it is recommended to sign in online to sync the latest
project information.

The default cache location is %localappdata%/InEight/Model/cache directory.

If your existing installation is not in the default location, switching to the default path is highly
recommended. To view your current path and update the default location click the ellipsis in your sign
in screen > Settings > Cache Path. You can then select a new location.

The cache must remain local on the computer and cannot be synced live to external locations.
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Do not delete your InEight Model cache folder. In rare instances you can delete the folder
to fix cache issues.

1.4.1 Move cache to a new location

If you installed Model before 23.10, you can change the location of your InEightModel_Cache folder in
Settings > Cache Path. Changing the location of your cache folder without moving your existing cache
folder data will force Model to recache the project data. This can be time-consuming depending on the
number of projects and their size.

1.4.2 Considerations

l The registry key located in Computer\HKEY_CURRENT_USER\SOFTWARE\InEight\Model\Cache
defines the path of where the InEightModel_Cache folder resides. Updating the path in the
registry will not relocate the existing cache folder to a new defined location

l If the cache folder is deleted, Model must re-cache the project data. This can be time-
consuming.

1.4.3 Steps

Moving your existing InEightModel_Cache folder

To move your existing Model cache folder, do the following recommended process. The process must
be done on the local machine of each user.

1. Open Windows File Explorer, and then create a new folder or open the new folder location.

2. Open another Windows File Explorer window, and then select your existing InEight Mode_Cache
folder location.

3. Move your existing InEightModel_Cache folder into the new location.

4. Launch the InEight Model application.

5. Click the Settings icon in the login window, and then change the Cache Path to the new location.

6. Sign in to InEight Model.
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Lesson 1 Review

1. What should you do prior to downloading and installing InEight Model?

a. Delete your authoring tool from your computer

b. Check your system's requirements

c. Download the correct plugin for your authoring tool

d. None of the above

2. What does InEight Model offer to support authoring tools?

a. AutoCAD plugin

b. Revit plugin

c. IFC importer

d. Navisworks

e. All of the above

3. You can create a new model from InEight model.

a. True

b. False

Lesson 1 Summary

As a result of this lesson, you can:

l Install InEight Model
l Install plugins
l Launch InEight Model
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LESSON 2 — PROJECTS

Lesson Duration: 20 minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Create and load projects

Topics in this Lesson



2.1 CREATE A PROJECT

Create a project integrated with InEight Platform

When Model is integrated with InEight Platform, all projects are created in Platform.

Create a project not integrated with InEight Platform

1. From the top menu, select File > New Project.

l The New Project dialog box opens.

2. Name the new project.

3. Click OK.
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l The creation in progress dialog opens.

4. Click OK.

After a project is created it cannot be renamed.

2.2 LOAD A PROJECT

Logging into an account provides access to projects in that account. To access a specific project, you
first must load it.

InEight Model integrated with InEight Platform will show all projects listed in Platform in
the Load Project dialog box.
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2.2 Step by Step 1 — Load a Project

1. Select File > Load Project....

l The Load Project dialog box opens and shows all projects you have access to.

2. Select a project.

3. Select OK.
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Right-click on a project. This provides additional options:

l Set as Highest Priority: This pushes the project to the top of the list when projects are
being Synced.

l Stop Syncing

l Hide Project From All Users: Administrators only have this functionality

2.2.1 Manage sync

You can only open models that have been cached to your computer. Manage Sync allows you to select
and reorder the projects you want to sync. After projects are synced, they are synced into the
InEightModel_Cache folder.
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l Download column: select on ^ Top to move a project to the top of the list to be synced first
l Sync column: If Sync is checked, then the project will sync. If Sync is un-checked then the
project will not sync

2.2.2 Remove projects from cache

You now can free up disk space by using the Remove project from cache option. When you finish
working on a project, remove the project from your cache in the Load Model Project > Load Project
tab. Right-click on a project from the list, and then select Remove Project from Cache to remove the
projects cache.
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You must exit InEight Model once a project has been removed before accessing and
working in another project.

2.3 CREATE A NEW PROJECT FROM TEMPLATE

In Model (not integrated with InEight Platform) you can create new projects from existing projects as a
template. The following items, if existing in the template project, will be created with the new project:

l Project Structure:
l The Project Structure folder structure will be present in the new project.
l No existing model streams will be present in the new project.

l Master Presets:
l The Master Preset folder structure will be present in the new project.
l No existing Master Presets will be present in the new project.

l Styles:
l All existing Style Sets with assignments to existing and non-existing tags with be
present in the new project.
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l All existing customer Styles will be present in the new project.
l Tags:

l All existing custom tags will be present in the new project.
l Archive Library:

l The Archive Library folder structure will be present in the new project.
l No existing documents or labels will be present in the new project.

InEight Model integrated with InEight Platform does not provide a means to create a
Model specific project from a template.

2.3.1 Considerations

l You must have admin permissions to create new projects.

l You can use projects as templates when Model is not integrated with InEight Platform.
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2.3.2 Steps

Create a New Project from Template

1. Select File > New Project from Template.

l The New Project dialog box will open

2. Type in the name of the New Project.

l The Template Project dialog box will open.
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3. Select the project to use as the desire Template, then click OK.

l A validation dialog box will open

4. Click Yes, if the information is correct.

5. Click OK, then load your new project

Lesson 2 Review

1. Before you can import a model, you should first create a project.

a. True

b. False

2. The Manage Sync folder allows you to sync projects to your _________________ .

a. Model Library

b. Cache Folder
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c. Model Stream

d. Plugin Folder

As a result of this lesson, you can:

l Create and load a project
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LESSON 3 — MODEL STREAMS

3.1 MODEL STREAMS OVERVIEW

A model that is published (imported) into InEight Model is referred to as a Model stream, whether they
are exported from a design application or imported from a design file type using plugin tools.

Each plugin tool has standard tags that are included in every published model as shown in the
following tables:

Tag category Tag value

Model Stream <model name>

Tag_Level <level names>

Tag_PhysicalType Window, Floor, Door, etc.

Revit_Family_Type <Family Instance names>

Revit_Function <Walls and Floors>

Material Name - CAD <face material names>

Revit

Tag category Tag value

Model Stream <model name>

ACAD Block <block names>

AutoCAD



Tag category Tag value

ACAD Layer <layer names>

ACAD Material <material names>

AutoCAD (continued)

Tag category Tag value

Model Stream <model name>

IFC Class <IFC class names>

IFC Layer <IFC layer names>

IFC Material <IFC material names>

IFC Name <IFC name names>

IFC

3.2 CONFIG SETTINGS

Config Options gives you the ability to define the parameters, or metadata, that will export along with
the geometry, as well as providing some advanced options for applying various transformations.

The Config Options column in theModel Exporter will report three different states.

1. Basic - Indicates the Config Options have not been defined by you. This is the default state
of an unpublished Model Stream.

2. Previous - Uses the same Config Options as a previous export. This indicates that you're
updating an existing Model Stream and not publishing a new one. The settings are pulled
from the previous project and are not dependent on the Model Stream being updated from
the same computer, or even by the same user.

3. Custom - Indicates that the Config Options have been modified during your current
session.
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Config Options can be configured in bulk by multi-selecting the listed Model Files in
the Model Exporter window then clicking within any of the Config Options field
that corresponds with your selection.

The Parameters tab in the Config Options window allows the user to define what metadata will be
exported along with the geometry. The Basic Tags are also displayed along the top of the search bar.
Basic Tags will be included in every export regardless of configuration.
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Choose your desired tags and/or properties by expanding a category and checking the box next to a
value. In the image below, we see that the Voltage and Wattage for the Electrical Equipment will be
exported as a tag and that the Length and Volume for Structural Columns will be exported as
properties. Additionally, clicking in the Click to rename... field in the Tag Alias Name column, the
Length of the Structural Columns has been renamed to Cut Length. Renaming these values is a quick
and easy way to achieve consistency when pulling geometry and metadata from files authored by
various different organizations that may be using different values to represent the same data.
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With the Show Unselected box checked (in the bottom left corner), all available parameters will be
displayed. With the Show Unselected box un-checked, only the selected parameters will be displayed,
this allows the user to easily view the current configuration.
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Use the Import Parameters and Exporter Parameters buttons to save your configuration to a local file
or to import a previously saved configuration.

The Advanced tab allows Scale, Rotate, and Translate (move) options upon export. Settings configured
in the Advanced Options are retained in future model updates.
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To change the name of the Model Stream simply click in the Rename Model Stream field and enter the
desired name.

If desired, check the Include Lines in Export box to include 2D and 3D line work.

l Scale, Rotate and Translate / Move provides a way to adjust the model as needed up
export

l Rename Model Stream provides a way to rename the model file upon export
o The new name will appear in the Objects panel and as a value within the Tag
Category "Model"

l Include Lines in Export provides a way to include 2D and 3D line work upon export

3.2.0.1 Overview - Configuring Model Streams Parameters tab

Item Description

1 Parameter Name Displays the Property Set Name and the Property Name of
the metadata.

2 Export Property Will export the Property Name with the existing value for
each model object.

3 Create Tag Will utilize the Property Name to create a Tag name with the
existing value for each model object.

4 Tag Alias Name Provides the capability to control what the Tag name is
during the export of the model.

5 Export Parameters Once the desired “Export Property”, “Create Tag,” and “Tag
Alias Name” columns have been selected and filled out, then
select Export Parameters to save these settings to use on
similar models.

6 Import Parameters If previous parameters have been exported, then select
Import Parameters to populate Parameters.
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3.2 Step by Step 1 — Config Settings - Parameters

1. Within the Model Exporter window, select Basic.

l The Config Options window opens with the initial focus on parameters

The Parameters tab in the Config Options window allows the user to define what
metadata will be exported along with the geometry.

The Basic Tags are also displayed along the top of the search bar. Basic Tags will be
included in every export regardless of configuration.
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2. Select the desired tags and/or properties to export with the Model Stream.

l Create Tag will create a tag category and tag value metadata for the relative model
objects

o Column Location Mark, Length and Volume will be the tag categories within
InEight Model

l Export Property will create property category and property value metadata for the
relative model objects

o Fire Rating and Manufacturer will be the Property Categories within InEight
Model

l Tag Alias name will rename the Category name
o Length will be renamed to Cut Length during the export
o Renaming these values is a quick and easy way to achieve consistency when
pulling geometry and metadata from files authorized by different organizations
that may be using different values to represent the same data
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3. Select or unselect Show Unselected.

4. Select Import Parameters or Export Parameters.

5. Select OK when you have completed.

3.2 Step by Step 2 — Config Settings - Scale / Rotate / XYZ

1. Select the Advanced tab from the Model Exporter.
l The Advanced tab shows options to manipulate the model.
l If the Scale Factor, Rotate, and/or the XYZ are needed to adjust the model then they
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are applied in the displayed order from top to bottom (Scale Factor > Rotate > XYZ).

2. Add a scale factor to adjust the scale of the model as needed.

3. Add a Rotation angle by degrees as needed.

4. Add X, Y, and Z coordinates as needed.

5. Click OK when done with Config Options.
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3.2 Step by Step 3 — Config Settings - Rename Model Stream

1. Select the Advanced tab from the Model Exporter.
l The model file name might change if the designer or architect puts a revision status
or date on the file name with every version.

l The Rename Model Stream lets you rename the model stream without changing the
model file name and provides a consistent model stream name for all end users to
access.

2. Type a Model Stream Name.
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3. Click OK when done with Config Options
l The Project Structure shows the Renamed Model Stream and, in the Revision
History, shows the Model Stream Source File name.

l The Tags and Objects panel shows the Renamed Model Stream in the Object tab for
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the project team to use throughout the project.

.

3.2 Step by Step 4 — Config Settings - Link to a different Model Stream

1. In the Model Exporter, you might see a message of “Resolve Model Conflict…**” in the
Location column. This is a result of multiple models loaded with similar names. Click
Resolve Model Conflict…**
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2. If the model stream is not shown, then click Export as New…
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3. Choose a location.
l You can only select the parent level or a group level location.

4. Click OK to close the Choose Location dialog box.

5. Click OK to close the Resolve Conflict dialog box.
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6. Click Basic in the Config Options column.

7. Click the Advanced tab.

8. Click Choose different model…
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9. In the Choose Location dialog box, select a Model Stream to link to.

10. Click OK when done with Config Options.

3.3 EXPORT SETTINGS

When available for plugin, Export Settings lets you configure the model location options and the model
visibility options.

3.3.0.1 Export Settings options:

Revit Location refers to the coordinate systems contained within the Revit Project and can be defined
three ways
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l Ask on Export - The Model Exporter will prompt the user to select the appropriate
coordinate system during export

l Use Revit Project Location - Uses the active project location
l Use None -Resets project location to default values

Export Selected will require the user to have an active selection prior to initializing the Model Exporter
and will only export selected objects

Visibility tells the Model Exporter which geometry to include in the export

l Export Visible - Exports all visible content within the 3D view
l Export Visible + Room Volumes - Exports all visible content within the 3D view plus room
volumes

l Export All - Exports all geometry found within the Revit project, even if it's hidden in the
active 3D view

Info displays some basic information about your current session

l InEight Connection - Displays the current status of the Model Exporter's communication
with InEight Model

l Connected - Online - Connection is established to the server
l Disconnected - Offline - Not connected to the server. Check your Internet connection or
login to your project within InEight Model

l Logged-in as - The currently logged in user
l Cache Location - The path of the InEightModel_Cache folder

3.3.1 Steps

Export Settings

1. In the Model Exporter window, select Change Export Settings / Show Info … to open the Export
Settings window.

InEight Inc.  |  Release 23.10 Page 61 of 490

Model User Guide 3.3 Export Settings



l The Export Settings window opens
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2. Complete your changes, and then click OK.

3.4 MODEL REVISIONS

Model revisions might occur during project execution.

3.4.0.1 Model with Same Name

Follow the same process of the initial exporting from AutoCAD or Revit or importing an IFC file.
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Notice the following parameters while updating the model.

l The Model file is the same file name that you have opened to update.
l The Location is populated from the previous selection and lets you export as a new model.
l The Config Options use the previous settings.

3.4.0.2 Model with a Revised Name

Follow the same procedure of the initial exporting from AutoCAD or Revit or importing an IFC file.

Notice the Model file has .rev2 added to it, different from the initial file name.

The system puts the revised model stream in the previously selected location.
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3.4 Step by Step 1 — Resolve Model Conflict

1. Select Resolve Model Conflict...

l The Resolve Conflict window opens

2. Select the applicable model stream to be revised.
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3. Select Export as New... if this is a new Model Stream.

l The Choose Location window opens.
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4. Select the preferred location in the Project Structure.

5. Select OK to complete.

When exporting a model with a similar name to more than one model, the system
shows Resolve Model Conflict… in the location column.

3.5 ANALYZE MODEL CHANGES

Analyze Model Changes provides the ability to compare models over time. The comparison is not
limited to two models, the comparison is triggered off two calendar dates, which could include 2 or
more model stream revisions.

The comparison will provide which model stream was compared, how many objects were added, how
many objects we updated, and how many objects were removed.
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The comparison will also create a new Tag Category named Tag_User with two tag values: (date range)
(Model Stream Name)_added and (date range) (Model Stream Name)_updated.

Also, a Style Set is created within the Styling Panel with the name (date range) (Model Stream Name)
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3.5 Step by Step 1 — Analyze Model Changes

1. Have two versions of the model stream published.

2. Within the Project Structure dialog box, select on a model stream to identify the date range
to use for the comparison.
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3. Close Project Structure dialog box.

4. Close Project Structure dialog box.
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5. Select the Model Stream, set the date time frames, then click OK.

l The Analysis of Model Changes Completed dialog box will open

l Tag_User category was created with two values “_added” and “_updated”
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l A Style Set was created coloring the “Added” objects Lime Green and the “Updated” objects
Orange
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LESSON 4 — PROJECT STRUCTURE

Lesson Duration: 50 minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Navigate the project structure panel
l Create and delete model stream groups
l Change active model stream revision and revise model stream revision
l Disable and remove model streams
l Add model streams from other projects

Topics in this Lesson



4.1 PROJECT STRUCTURE OVERVIEW

Project Structure is where model streams are housed after the export from authoring tools or the
import of IFC type files. It provides the ability to interact with model streams by grouping and
organizing, removing, temporarily disabling, accessing the revision history, importing other models
streams from other projects in the environment, and more.

4.1.1 Project Structure Panel

To access the Project Structure panel, Select File from the menu bar at the top of the screen. Then,
select Project Structure.

This will open the Project Structure panel.
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By selecting the project name within the tree structure, all the project Revision History will be
displayed. Select on a revision to review the Revision Notes.
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4.2 ORGANIZE MODEL STREAMS

Create groups within the Project Structure tree to organize the model streams for the project. Groups
can be created before and or after model streams have been imported into the project. Model Stream
Placeholders can also be created identifying anticipated or planned project model streams.

4.2 Step by Step 1 — Create Groups

1. Select the project name.

2. Select the Group icon.
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3. Type in a group name, then click OK.
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4. Drag and drop model streams into group folders.
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l Possible results of organized models

Once a group name has been created it cannot be renamed. A new group name will need
to be created, then you can drag and drop the model streams from one group to the
other.
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4.2 Step by Step 2 — Delete Groups

1. Select the group name to be deleted.

2. Select the Remove icon.
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l The Remove Model Group confirmation dialog box will open

Any model streams within the group that is being removed will be removed as well.
The model streams will remain in the database, but not visible within the current
project.

The Project Structure will be replicated within the Objects tab within the Tags and
Objects Panel.
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4.2 Step by Step 3 — Creating a Model Stream Placeholder

1. Select on the Project or the Group for the desired Model Stream placeholder.

2. Select the Model Streams icon.
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3. Select the Add Placeholder icon.

l The Remove Model Group confirmation dialog box will open

4. Type in the anticipated or planned Model Stream name.

l The Model Stream Placeholder will appear in red until a model stream is uploaded in
its place
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4.3 MODEL STREAM MANAGEMENT

When a model stream is updated from a plugin, a new revision is created in the Project Structure. The
Project Structure lets the administrator switch the revision of any given model stream in the project.

4.3 Step by Step 1 — Change the Active Model Stream Revision

1. Within the Project Structure tree, select a model stream.

2. Double click on an older revision.
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The current active revision is highlighted in green and the most recent prior
revision is highlighted in yellow.

If an administrator changes the revision of any model stream and proceeds to save
the project, any user loading the project or accepting updates will also be viewing
the historical revision chosen by the administrator. This allows the administrator to
roll back to a previous revision, if the latest revision is incorrect or non-compliant.

A model stream will be highlighted in yellow if there is a new model stream
revision, but not set as the active revision.

InEight Inc.  |  Release 23.10 Page 85 of 490

Model User Guide 4.3 Model Stream Management



Page 86 of 490 InEight Inc.  |  Release 23.10

4.3 Model Stream Management Model User Guide

3Management_SxS1_ModelStreamInYellow.png


4.3 Step by Step 2 — Update Model Stream Revisions

1. Within the Project Structure panel, click the Update All icon.

Update all will update all model streams to the latest revision.

The Update All icon will not be available if there are no old revisions active.

4.3 Step by Step 3 — Disable Model Streams

1. Uncheck the box next to the model stream.

2. Click OK.

3. Save the project.
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l Once the project is saved, then the model stream is hidden from the project users

4.3 Step by Step 4 — Remove Model Streams

1. Select a model stream.

2. Select the Remove icon.
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l The Remove and Discard dialog box will open

l Remove Only -will remove the selected model stream from the current project
but it will not remove it from the database

l Remove and Discard – will remove the selected model stream from the
database.
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4.3 Step by Step 5 — Adding Model Streams from Other Projects

Model streams that have been removed with the Remove Only command can be reloaded through the
Add Model Stream icon.

Model streams within the same environment, but in a different project, are accessible to be included in
any project within the same environment.

1. Select the root project name or a group folder.

2. Select the Model Stream icon.
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l The Model Stream dialog box will open

3. Select the desired models to be added to the current project, then click OK.

The select model stream of the particular revision date will be added to the current
project along with all older revisions of the model stream.
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4.3 Step by Step 6 — Publish a Model Stream into a Placeholder

Model Stream Placeholders show as red until a model has been published to replace it.

1. With Model open and the Design Authoring tool (that is,Revit) open, select the Export
Model Stream icon.

l The Model Exporter dialog box opens.

2. Select Choose Location.
l Even though there is a placeholder that nearly matches the name of the design file,
the design file has not been published yet, so it is recognized as a new model
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l The Choose Location dialog opens.

3. Select the folder where the Model Stream placeholder is identified.
l In this example, Mechanical is the placeholder.
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4. Click OK.

The new model stream does not replace the placeholder until it is linked to it.
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5. Select Basic config options.
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6. Select the Advanced tab.
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7. Select Choose different model...
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8. Select the model stream placeholder, and then click OK.
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9. Click Start.

10. Save the model stream to the project.
l In the Project Structure, the new Model Stream has replaced the Model Stream
placeholder.

4.4 MODEL STREAM PERMISSIONS

Permissions can be set at the Group level within the Project Structure. Nested groups inherit parent
group permissions.

By default, group permissions inherit project permission for users and user groups.
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For best practice, only apply User Groups to projects instead of individual users. This minimizes the
management of applying permissions to Model Streams.

4.4 Step by Step 1 — Apply Permissions to Groups

1. Open the Project Structure dialog box.

2. Right-click on a group and select Edit Group Permissions.

l The Edit Model Group Permissions dialog box opens.

l By default, the User Parents Group Permissions is already checked.

3. Uncheck the Use Parent Group Permissions check box to apply specific User Group permissions.
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l All users and User Groups show if they have been assigned to the project.

4. Users and User Groups can only have one of the following permissions:

l Can Read – read-only permissions.

l Can Read and Write – read, write, and edit permissions.
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5. Users that have been assigned to the project within a Group have the Can Read permission in
the Edit Model Group Permissions dialog box.

l User Groups that display the project permissions are currently only set at the project level.

6. Use the Account Manager dialog box to reference the users assigned to Groups in specific
projects.

l For more information on the Account Manager dialog box, reference the Managers Users
and Manage User Groups topics.

7. Set the permissions for the selected group or user.

8. Log in as the specific user or group to publish a model.
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Lesson 4 Review

1. In the Project Structure tree, groups can only be created before model streams are
added.

a. True

b. False

2. Once a group name has been created, it cannot be edited or renamed.

a. True

b. False

Lesson 4 Summary

As a result of this lesson, you can:

l Navigate the project structure panel
l Create and delete model stream groups
l Change active model stream revision and revise model stream revision
l Disable and remove model streams
l Add model streams from other projects
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LESSON 5 — USER INTERFACE

Lesson Duration: 30 minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Navigate InEight Model
l Select model objects
l Use common hot keys

Topics in this Lesson



5.1 VIEWER INTERFACE

The Viewer interface (Workspace) is highly configurable. Tools and panels are accessed through a
series of menus located across the top of the application and a notification panel located across the
bottom of the application.

Panels can be opened, closed, rearranged, and docked into various configurations. Move, dock and un-
dock panels by dragging the panel title bar.

Hold Ctrl before dragging a panel to prevent it from docking automatically.

l Some Panels have multiple areas, differentiated with tabs:
l When panels are docked on top of one another, each panel is represented as a tab
l Tabs can be on top, side of, and bottom of a panel
l Select the tab to activate a specific panel or area of a panel
l The active panel tab is highlighted in orange
l Re-size undocked panels by clicking and dragging the panel edge
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l Resize a docked panel by clicking and dragging the edge of the panel

5.1.1 Docking Panels:

l While moving a panel to dock at the Top, Bottom, Left or Right, the Viewer will respond by
indicating a space for the panel to be docked
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l Panels can be docked at the Top, Bottom, Right, and Left of the viewer

l Panels can be docked on top of one another
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l Panels can be docked at the top or bottom of another panel

l Panels can be docked beside another panel
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l Panels can be docked in between two panels

l Panels can be stand alone on the same or different monitor
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5.2 SHOW MODEL SPOTS

Model Spots provide the ability to easy find those model streams that are not aligned on the same
coordinate.
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5.2 Step by Step 1 — Show Model Spots

1. Select View > Show Model Spots.

2. Zoom out until red dots are visible or click the Home key on the keyboard.
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3. Hover over a dot to see the model stream name(s).

4. Double-click on a model spot to zoom into the model stream(s).

5.3 NAVIGATION

InEight Model allows you to move through, zoom, pan, and change perspectives within the 3D space
surrounding your model. To begin, load or open a model. The navigation widget will appear in the top,
right corner of your window and will rotate as you navigate to indicate your camera’s position and
direction in space.

If the navigation widget is not present in the top, right corner of your screen, there is
nothing to navigate; load a model.
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In InEight Model, the viewer interaction is focused on the center of the view and not the model
objects. This allows you to see all objects from your camera perspective as you navigate and interact
with objects. To quickly return to the designated “home” view of a model, you can navigate up to the
menu, click View, and select Home Position from the drop-down menu.

Function Action Description

Orbit Left click and hold to revolve around, or
orbit, the object or model

Pan
Right click and hold to maintain the
object’s position while moving, or
panning, your view of the object or model

Navigation Controls
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Function Action Description

Zoom (to Center of
view)

Scroll the wheel away from you to zoom
in and toward you to zoom out

Zoom to Cursor

Hold the CTRL key and use the scroll
wheel to zoom to, and away from, the
cursor. Your cursor must be over a
model element

Zoom to Object / Set
Center

Double left click an object to zoom the
camera to an object. This will set the
center of orbit to the object

Zoom to Selected
Objects

Select an object and press the F5 key to
zoom the camera to frame the selection

Zoom to Home
Position

Use the Home key or double click the
mouse wheel to zoom the camera to
frame the extents and home position of
the 3D environment

Navigation Controls (continued)
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Function Action Description

Orthographic
& Perspective
Views

Toggle between the Orthographic and
Perspective view modes

Camera Settings
(Perspective View)

Camera Settings enable you to change
the focal length of the lens through which
you are viewing the model . Right click on
the camera icon and click Camera
Settings Panel to adjust your setting. This
setting is only available in Perspective
View

5.3.0.1 First Person Navigation

First person navigation positions the camera view where it assumes your eyes would be and
what they would see in relationship to the model environment.

First Person Toggle

Navigation Controls (continued)
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Function Action Description

Walk Speed
Walk Speed enables you to change the
speed up or slow down when walking
through the model

Navigation Controls (continued)

5.4 SELECTION

InEight Model allows you to manipulate the way you view, manage, and interact with the objects that
make up your model(s). Many of these features are available as hot keys and within a drop-down
menu.
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Function Action Description

Select Object

OR

Allows you to select an object

Select Object
Transparent

Allows you to select transparent
objects

Select Style
Provides a means to select like objects
with the same style (enabled only if
one object is selected)

Selection Controls
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Function Action Description

Add / Remove to
Selection

OR

Adds unselected objects to the current
selection set, or, removes selected
objects from the existing selection set

Window Selection

OR 

Selects objects completely within the
window

Selection Controls (continued)
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Function Action Description

Crossing Selection

OR

Selects objects that are both
completely in the window and those
that cross into the window

Select All
Initiates the select all action. A dialog
box will appear to confirm this action

Selection Controls (continued)
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Function Action Description

Invert Selection Inverts the selection set of objects

Restore Previous
Selection

Restores the selection set to the
previous selected objects

Selection Filter
Opens the Selection Filter dialog box
and allows you to filter down the
selection set

Clear Selection Clears the current selection

Select Related Tag
Provides a means to select like objects
with the same tag

Selection Controls (continued)
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Function Action Description

Copy Selection to
Clipboard

Provides a means to copy the select
object's metadata to the clipboard

Selection Controls (continued)
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Function Action Description

RCM - Select
Object

Right click on top of an object,
then click Select Object

RCM – Select
Related Tag

Provides a means to select like
objects with the same tag.

RCM – Select
Style

Provides a means to select like
objects with the same style.
(Note: enabled only if one
object is selected)

RCM – Add
Object to
Selection

Right click on top of an object,
then click Add Object to
Selection

RCM – Select
Objects
Contained in
Selection

Provides a means to select all
objects contained within the
object

RCM – Select
Objects
Intersecting
Selection

Provides a means to select all
objects inside and intersecting
with an object

RCM – Copy
Selection to
Clipboard

Provides a means to copy the
selected object’s metadata to
the clipboard

Right Click Menu Selection Controls

5.4.0.1 Right Click Menu

l The Selection Menu offers all the selection commands listed in the table above, except
Delete Selected Objects and Copy Selection to Clipboard (see the table above for
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descriptions)

l The Show/Hide Menu offers even more options – many of which are also accessible as hot keys.
See the table below for descriptions
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Function Action Description

Isolate Mode Toggles between the entire model
and an isolated view of the
selected objects

Show Selected Shows all selected objects

Hide Selected Hides all selected objects

Hide Unselected Hides all unselected objects

Hide Models from
Selected

Hides all models from the selected
objects

Model Object View Controls
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Function Action Description

Hide Models from
Unselected

x

x

Hides all models from the
unselected objects

Show All Shows all objects and models in a
project

Undo View State
Changes

Undo up to the last 10 view state
changes

Redo View State
Changes

Redo up to the last 10 view state
changes

Toggle Full Screen Toggles the window size and
position between a customizable
(F11) and full screen window

Model Object View Controls (continued)
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Function Action Description

Show Model Spots Marks the model’s spot within the
space so that the model is
identifiable no matter how far out
you zoom

Model Object View Controls (continued)

5.5 SELECTION MODE

Selection Mode provides the ability to select objects related to the active mode.

• Last Object will select the lowest level of an object (a child)

• First Object will select all objects that belong to the highest level (a parent)

• IWP will select all objects that belong to the IWP associated to the object being selected

• CWP will select all objects that belong to the CWP associated to the object being selected

• Elements will select objects that belong to the Element associated to the object being selected

• Tag Name will select objects that belong to the Tag associated to the object being selected

Any object can be selected no matter what mode is active. If the object selected does not
have data associated to it for the active mode, then the Last Object mode will be the
default.
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5.5.1 Selection Mode Indicator

Selection Mode is always active and will be displayed at the bottom right within the viewer.

5.5.2 Selection Mode - Last Object

Last Object selection mode will select the lowest level of the object.

5.5.3 Selection Mode - First Object

First Object selection mode will select the highest level of the object and select all objects associated to
the parent level.
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5.5.4 Selection Mode - IWP

IWP selection mode will select all objects that belong to the IWP associated to the object being
selected.
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5.5.5 Selection Mode - CWP

CWP selection mode will select all objects that belong to the CWP associated to the object being
selected.
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5.5.6 Selection Mode - Element

Element selection mode will select all objects that belong to the Element associated to the object
being selected.
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5.5.7 Selection Mode - Tag

Tag selection mode will select all objects that belong to the Tag associated to the object being
selected.
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5.6 HOT KEYS

Click to open a one page PDF copy of the InEight Model Hot Keys.

Function Action Description

Orbit Left click and hold to revolve
around, or orbit, the object or
model

Viewer Navigation
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Function Action Description

Pan

Right click and hold to
maintain the object’s
position while moving, or
panning, your view of the
object or model

Zoom (to center of view) Scroll the wheel away from
you to zoom in and toward
you to zoom out

Zoom to Cursor

Hold the CTRL key and use
the scroll wheel to zoom to,
and away from, the cursor.
Your cursor must be over a
model element

Zoom to Object / Set Center Double left click an object to
zoom the camera to an
object. This will set the center
of orbit to the object

Zoom to Selected Object

Select an object and press
the F5 key to zoom the
camera to frame the
selection

Viewer Navigation (continued)
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Function Action Description

Zoom to Home Position Use the Home key or double
click the mouse wheel to
zoom the camera to frame
the extents and home
position of the 3D
environment

First Person Toggle

Adjust Walk Speed Walk Speed enables you to
change the speed up or slow
down when walking through
the model

Viewer Navigation (continued)
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Function Action Description

Select Object

OR

Allows you to select an
object

Select Transparent Object
Allows you to select
transparent objects

Add / Remove to Selection Adds unselected objects to
the current selection set, or,
removes selected objects
from the existing selection
set

Model Object Selection
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Function Action Description

OR

Window Selection

OR 

Selects objects completely
within the window

Crossing Selection Selects objects that are both

Model Object Selection (continued)
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Function Action Description

OR

completely in the window
and those that cross into the
window

Select All
Initiates the select all action.
A dialog box will appear to
confirm this action

Invert Selection Inverts the selection set of
objects

Model Object Selection (continued)
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Function Action Description

Restore Previous Selection
Restores the selection set to
the previous selected
objects

Selection Filter Opens the Selection Filter
dialog box and allows you to
filter down the selection set

Clear Selection Clears the current selection

Model Object Selection (continued)

Function Action Description

Isolate Mode Toggles between the entire
model and an isolated view of
the selected objects

Model Object View
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Function Action Description

Show Selected Shows all selected objects

Hide Selected Hides all selected objects

Hide Unselected Hides all unselected objects

Show All Shows all objects and models
in a project

Show Model Spots
Marks the model’s spot within
the space so that the model is
identifiable no matter how far
out you zoom

Model Object View (continued)
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Function Action Description

Toggle Full Screen Toggles the window size and
position between a
customizable (F11) and full
screen window

Model Object View (continued)

Function Action Description

Selection Information Opens the Selection
Information Panel where you
can view the attributes and
metadata of your selected
objects

Master Presets Opens the Master Presets
Panel where you can
quickly select or create a
master preset

Coordination Opens the Coordination
Panel where you can quickly
run rules and see your
results

Panels
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Function Action Description

Data Transformation
Operations

Opens the Data
Transformation Operations
Panel

Panels (continued)

Function Action Description

Tag Selected Opens the Tag Panel to
allow you to select and apply
tags to your selected objects

Actions

Function Action Description

Load Project

Opens the Load Model
Project Dialog Box where
you can quickly load
additional models

Other
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Function Action Description

Command History

Opens the Command
History Panel where you can
view any and all saved
changes

Other (continued)

5.7 USER SETTINGS

Within the Settings icon in the top left of the menu bar, a user can modify their user settings. Toggle
to:

l Work Online/Offline
l Adjust User Settings
l Change Password
l Edit Contact Information
l Save Workspaces
l Reset Workspace
l administrators can access User Management through Admin
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5.7.1 Settings...

Provides the ability to change:

l Mouse/Keyboard Mapping changes
l Choose Default Zoom Behavior
l Set the Coordinate Display Units
l Change the Background Color
l Choose Selection Display Style
l Invert Scroll Wheel in First Person

5.7.2 Mouse / Keyboard Mapping

Allows for the user to change any of the shortcuts to their working experience desire
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5.7.3 Choose Default Zoom Behavior

Allows for the user to set Zoom to Center or Zoom to Cursor.
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5.7.4 Coordinate Display Units

Allows for the user to set the coordinate display units. This does not change the scale of the model.
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5.7.5 Background Color

Allows for the user to change the background color of the 3D viewer.
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5.7.5.1 Choose Selection Display Style

Allows for the user to manage display of selected objects. Manage the ability to show lines (edges) of
the objects in a desired color and the ability to color selected objects with a fill color.

Choose Fill Color… also has transparent settings.

5.7.6 Invert Scroll Wheel in First Person

Allows for the user to manage the "head tilt" within the First Person.
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5.8 CREATE NEW MARKUP

A new markup can be created within the viewer and saved to a PDF file. Access it through View ->
Create New Markup. Once Create New Markup is selected, a snapshot of the current 3D Viewer is
captured and ready for a markup.
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The markup capabilities allow the user to place Arrows, Scribble, Ellipse, Rectangles, and Text.

The text size can be adjusted with the Thickness bar.

l Set the Color, Thickness and line type to a Solid or Dashed before placing an object
l Once objects are placed, they cannot be edited. They can, however, be deleted by
selecting the object, then select the DEL key on the keyboard.

l Text color and size can be edited after placement. Select and highlight the text, then select
edit color and/or move the thickness bar to change the text size.

Select Save to… to save the markup as a PDF file.
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Once the new PDF file is saved, the existing markup is still active.

Select Clear Markups to clear all markups.

Select Back to Model to toggle from the New Markup to the 3D Viewer

Select the red X to close the Markup tool.

5.9 GRIDS

If grids are part of the Revit project, then they are included in the export process.
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Grids can be toggled on and off through the main menu. Use the following step by step to toggle the
grids on or off.

5.9 Step by Step 1 — Toggle on or off grids

1. From the main menu, click View.

2. Select Show Grids.

Grids can also be toggled on and off from the notification panel at the bottom left in the application.
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Lesson 5 Review

1. How can you navigate in InEight Model?

a. Using your mouse

b. Using the Navigation Widget

c. Using hot keys

d. All of the above

2. If you right click on your mouse, what two menus appear?

a. Trash, Model settings

b. Plugin History, Show/Hide

c. Show/Hide, Selection

d. Selection, Trash

3. You can navigate a model from a First Person View.

a. True

b. False

Lesson 5 Summary

As a result of this lesson, you can:

l Navigate InEight Model
l Select model objects
l Use common hot keys
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LESSON 6 — PROJECT UPDATES AND
HISTORY

Lesson Duration: 30 minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Access and review your model's history
l Understand how to update your project from the Project Update window
l Access the history of the commands taken on your project prior to saving Access and
review

Topics in this Lesson



6.1 COMMAND HISTORY

As content is added to the model environment, a complete history is tracked, saved, and accessible
anytime through the lifetime of the project. The Command History panel provides the insight as to
what actions have been taken before they have been saved to the project.

The Command History panel is located from the main menu, Edit -> Command History or with the
Ctrl+H hotkey.

As changes are created within the model environment, they are listed in the Command History until
the user saves the changes to the project. Also, there will be an * following the project name to
indicate that there are changes.

You can undo any changes by selecting a previous change or selecting <empty>. Notice that the project
name no longer has an * following the name.
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To reactivate the changes, simply select on the last change that you want applied to the project. Then
Save the changes to the project with Ctrl+S or select File -> Save Project…

The Save Changes dialog box will open with a description of the project changes.

6.2 PROJECT UPDATES

When a user has saved updates to the project each user currently within the project will get a notice:
You have project updates.
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Right click on the green sync icon and select Update Now to retrieve the latest project updates.

Or select Project Updates Panel to review the Update Details and by who. Once reviewed, then click
Update Now to update your current session with the latest project updates.
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If there are and a user tries to save their project changes, then a Project Not Current dialog box will
appear, requiring the user to perform a project update before a project save can take place.

6.3 PROJECT HISTORY

Project History allows users to view a project at any stage, from the beginning all the way to the end of
a project.

The Project History panel is located from the main menu, File -> Project History or with the
Ctrl+Shift+H hotkey.

InEight Inc.  |  Release 23.10 Page 159 of 490

Model User Guide 6.3 Project History



The Project History panel provides the ability to look at the project in a historical view. This can be
achieved by:

l Jump to date and then click Go
l Project Revisions – search revisions made by a particular user or search for keywords from
the Revision Notes history.
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l Revision Date – double click on a revision date

When an older revision is activated, a red box will appear around the 3D Viewer and the project will be
rolled back to that particular time in the project’s history.
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In order to get back to the current version of the project, double-click on the first date
listed at the top of the Revision Date list. Once the model is back to the current version,
the red box will disappear.
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Lesson 6 Review

1. Once you've made a change in model, the previous state can never be recovered.

a. True

b. False

2. Users cannot save changes to their project if a project update is available.

a. True

b. False

Lesson 6 Summary

As a result of this lesson, you can:

l Access and review your model's history
l Understand how to update your project from the Project Update window
l Access the history of the commands taken on your project prior to saving Access and
review
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LESSON 7 — TAGS AND OBJECTS

Lesson Duration: 30 minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Create custom tags and edit tags
l Create and edit dynamic tags
l Assign and remove tags

Topics in this Lesson



7.1 TAGS AND OBJECTS OVERVIEW

Tags are the organizational structure of model objects and define a set of identifiers (category and
value). When you export a model through Revit or AutoCAD, or import an IFC file, you are creating tags
and objects metadata.

Interact with tags to manipulate your model in a variety of ways, including: 

l Selecting a group of model objects
l Visualizing your model with styles associated to tags
l Creating custom tags to enhance a model's value
l Linking documents and photos to tags
l Creating coordination rules to detect clashes

7.1.1 Tags and Objects Panel

To access your project's tags and objects, select View from the menu bar at the top of the screen.
Then, select Tags and Objects.

l This will launch the Tags and Objects panel

7.1.1.1 Objects Tab

The Objects tab within the Tags and Objects panel displays all the model streams that are available
within your project.
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Search for objects in the search bar or use auto-scroll to expand the list of tags that relate to your
selected model object(s).
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7.1 Step by Step 1 — Toggle Model Streams Visibility

1. From the Tags and Objects panel, select the Objects tab.

2. Toggle the View check box to turn the visibility of Model Streams on or off.

7.1.1.2 Tags Tab

The Tags tab displays all the tags imported with the model streams and any dynamic or custom tags
created.
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Select a tag category to expand its list of tag values or use the search bar to find a tag.
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7.2 CREATE AND EDIT TAGS

Tags are fixed, or static, values within a defined category that help describe the objects to which they
are assigned. You can only associate a model object to one Tag Value within a Tag Category. Create
tags through the Model Exporter/Importer, manually in InEight Model or import tags from Excel. Use
tags to help define and view your model through different lenses.

7.2.1 Manually Create and Edit Custom Tags

Use custom tags to transform design models into construction models or owner models.

Add custom tags to:

l Normalize data to your specific nomenclature
l Unique Identifications
l Status
l Endless possibilities…
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7.2 Step by Step 1 — Creating Tags

1. From the Tags and Objects panel, select the Tags tab.

2. Next, select the Add icon.

If there are model objects selected, Ctrl+T will open the Tag dialog box.
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3. The Tag dialog box will open. Enter a tag category name and select Add New.

l Once you select Add New, the new Tag Category is created and selected

If you select OK without first selecting Add New, you will close the Tag dialog box
without saving your tag category name.
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4. Enter a tag value and select Add New.

5. Now, select OK to save your new tag(s).
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If any model objects are actively selected, a note will appear in the Tag dialog box
asking you to confirm that you want to apply your tag to those selected objects.
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6. Your new tag will appear in the Tag panel.

7.2.2 Delete a Tag

Any tags from the Model Exporter / Importer process deleted are not really deleted. They are still in
the database but hidden from the Tag panel. The next Model Exporter / Importer process will not
import any tag that has been deleted.
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7.2 Step by Step 2 — Deleting Tags

1. From the Tags and Objects panel, select the Tags tab.

2. Select the tag category or tag value(s) you want to delete, then click on the Delete icon.

7.3 CREATE AND EDIT DYNAMIC TAGS

Unlike static tags, dynamic tags are controlled by rule sets. They are powerful tools in creating custom
groups of objects for various interactions. Use Dynamic tags to configure coordination rules and
normalize data.
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7.3 Step by Step 1 — Creating Dynamic Tags

1. Open the Tags and Objects panel.

2. Check that no model objects are actively selected.

3. Select the Add icon to open the Tags dialog box.

4. Select the Dynamic tab.
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5. Enter a name and select a category from the drop-down menu or select New....

6. Select either ANY or ALL from the drop-down menu.

ANY includes any object from ANY of the tags selected.
ALL includes objects that have ALL of the tags selected.

7. From the existing tags list on the left, select the tag(s) you want to include.
l Use the top arrow to direct that tag from the existing options to your dynamic tag
inclusion list on the right. Repeat until you have moved all desirable tags to the
included list on the right
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Existing Tags can be multi-selected by holding CTRL or SHIFT keys on the
keyboard.

8. From the existing tags list on the left, select the tag(s) you want to exclude.
l Use the bottom arrow to direct that tag from the existing options to your dynamic tag
exclusion list on the right. Repeat until you have moved all undesirable tags to the
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excluded list on the right

The same tag cannot exist in both the included and excluded fields.

9. Preview the results of your dynamic tag by selecting the Preview icon.
l This will select all model objects that meet the Dynamic Tag criteria
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10. To save this dynamic tag, select OK.

Dyanmic tags will not appear in the Existing Tags Column, and therefore cannot be
used in another dynamic tag.

Within the Tags and Objects panel, under the Tags tab, Dynamic tags appear in
italics.
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7.3 Step by Step 2 — Editing a Dynamic Tag

1. Open the Tags and Objects panel.

2. Select the dynamic tag you want to edit. Select the Edit icon or right click and select Edit
Dynamic Tag from the drop-down menu.

7.4 ASSIGN AND REMOVE TAGS

7.4.1 Assigning Tags

Assign custom created tags to model objects to enrich the model with actionable metadata.

7.4 Step by Step 1 — Assigning Tags

1. Select desired model objects.

2. Use the Tags hot key Ctrl + T, or right click to view the Selection Menu.
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3. From the Selection Menu, click on Tag Selected Objects.

4. From the Tags dialog box, select a tag category and value(s) you wish to apply to your selection.
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5. Click OK.

Clicking OK will apply the selected tag to the actively selected objects.

If the desired tag category or value is not available, then simply create it, then
select OK.

7.4.2 Removing Tags

Quickly remove tags from model objects.

InEight Inc.  |  Release 23.10 Page 185 of 490

Model User Guide 7.4 Assign and Remove Tags



7.4 Step by Step 2 — Removing Tags

1. Select desired model objects.

2. Right click to view the Selection Menu.

3. From the Selection Menu, select the tags you want to remove from your selected objects.

7.5 COPY METADATA FROM MODEL TO EXCEL

Metadata can be copied from your model into Excel by selecting the whole model or specific parts of
the model, copying that data to the clipboard, and then pasting that data into excel.

The following step-by-step walks you through how to copy metadata from Model to Excel.
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7.5 Step by Step 1 — Copy Metadata from Model to Excel

1. Select model objects.

2. Right-click anywhere in the viewer and select Selection > Copy Selection to Clipboard.
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3. Open Excel, and then paste the copied items.

All metadata associated with the selected objects is now pasted into Excel.

7.6 TAG DATA EXPORTER

The Tag Data Exporter provides the ability to identify a Tag to pivot off of. It also lets you identify your
desired related tags to include in an export of model metadata into a CSV file. The configurations can
be saved for repeatable use. These configurations can also be imported and exported as needed for
other projects.

7.6 Step by Step 1 — Export Tag Data to CSV file

1. Right-click the Tags tab in the Tags and Objects panel.

2. Select Tag Data Exporter....

3. Select a Tag, and then move it to the Identifier/Pivot Tag field.
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4. You can be specific with the Tag values by removing any values that you do not want to be
a part of the export. Select the tag values, and then click Remove .
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5. You can also be specific with the Tag values by selecting your values, and then moving
them into the Identifier/Pivot Tag area.
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6. Select additional Tags, and move them to the Tags to be exported field.
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7. Enter a Configuration Name and click Save to access this configuration again.
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8. The saved configurations can be imported, exported, and deleted.

9. Toggle the Include Objects Column if you want the data exported to be combined into like rows
according to the data with a leading column providing a count of objects meeting that row of
data.
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10. Click Export All… to export all data related to the configuration into a CVS file.

11. Click Export… to only export data related to the configuration and the model objects currently
selected.

l CVS file with the Object Column
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l CVS file without the Object Column

7.7 IMPORT TAGS FROM EXCEL

Custom Tags can be imported from Excel into the model.

Within Excel, one column needs to contain a unique tag for the Category Tag / Category Values that
exist within the model.

Assign custom created tags to model objects to enrich the model with actionable metadata.
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7.7 Step by Step 1 — Import Tags from Excel

1. Establish Unique ID information within excel. (i.e., Asset_ID in column A.)

Asset_ID has to be an existing Tag Category along with the information in cells A2
thru A20 must be existing Tag Values within the model.

Asset_ID cannot have any duplicates.

Model Objects must be assigned to the Unique ID.
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2. Establish metadata to import into the model. (i.e. Installation Status in column B)

3. Select the InEight tab within the Excel ribbon.
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4. Select a cell within the Unique ID column.

5. Within the Actions menu, select Set ID Tag.

The Set ID Tag will change from <none> to the column header. (i.e. Asset_ID)
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6. Select a range of cell(s) within the column of data to import.

7. Within the Actions menu, select Bulk Assign Tags.
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8. Import multiple columns of metadata, by selecting a range of cells that span columns.

9. Within the Actions menu, select Bulk Assign Tags.

There will be NO indication notice that the data has been imported.
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10. Results:

7.8 SELECT MODEL OBJECTS VIA EXCEL

Model objects can be auto-selected and framed in the model viewer by selecting tag values in Excel. In
Excel, the top row represents the Tag Category. Any row below the top row represents the Tag Value.
The Tag Category and Tag Value must be exactly the same in Model in order for Excel to interact with
Model.

The following step-by-step walks you through how to auto-select Model objects in Excel.

The following steps require the Excel Plugin to be installed.
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7.8 Step by Step 1 — Select Model Objects via Excel

1. From Excel, select the InEight tab from the top menu.

2. Under the Project section, Click Login.

The Login to InEight dialog box opens.

3. Login using the same credentials for InEight Model.

4. Select the project you are currently in, and then click OK.

5. In Excel under the InEight tab in the Modifiers section, select the check marks for both Auto
Select and Frame Selected.

6. Select a tag value from the metadata copied from the Model into Excel.

7. In the Actions section, click Select Tag.
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7.9 CREATE TABLES OF EXTERNAL DATA

Only a Project Admin can create Generic Tables to import external data and link to a
Unique ID Tag in Model.

External information can be accessed in Model but is managed externally using Excel.

7.9.1 Identify the model Unique ID

The following step-by-step walks you through how to identify the model Unique ID in Excel.

The following steps require the Excel Plugin to be installed and for a Project Admin to be
logged into the InEight Excel Plugin.
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7.9 Step by Step 1 — Identify the model Unique ID

1. After you log into Excel, use the first column (cell A1) to match a Tag Category in Model.

Columns B and beyond can contain additional columns of data as needed.

2. Rename the Tab to the preferred Table Name.

Although this is not a required step, it can provide clarity as you develop the extra data.

3. Under the InEight tab in the Data section, select Table.

4. From the drop-down menu, in the New Table section, select Create new Table.
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5. From the Create new Table data box:

a. Select the check mark for Use headers from current Excel worksheet.

b. Confirm the Schema Name is labeled with the preferred name with no spaces.
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c. Select Generic Table for the Table Type.

6. Select one item to be the Identifier (i.e. 00 – Asset).

This must be a pre-existing Tag Category in Model.
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7. In the Data Type column, choose the correct Data Type for each Column Name.

All data types are defaulted to Short String.

l String: can contain any sequence of characters

l Integer: a whole number (not a fractional number) that can be positive, negative, or zero (-
5, 1, 5, 8, 97, 3243)

l Location: GPS latitude and longitude coordinates

l Short String: can contain any sequence of characters limited to 32 characters

l If this is chosen, make sure that your data will not extend beyond 32 characters or
you will encounter an error when uploading data.

l TimeStamp: a seven part value representing a date and time by year, month, day, hour,
minute, second

InEight Inc.  |  Release 23.10 Page 207 of 490

Model User Guide 7.9 Create Tables of External Data



l GUID: Global Unique ID

l Unsigned Integer: often called units which are zero or positive numbers

l Long Integer: longer than an integer

l Float: a number that is not an integer, because it includes a fraction in decimal format

l Double: can represent a fractional and whole values and can use exponential notation
(1.0e6 to represent one million)

You can add or remove any of the column name fields.

8. After all Column Name fields have the preferred Data Type, select OK to create the Generic
Table.

The new tab is then shaded in red to showthat it is now a table available in the Model database.

Three new fields also show: Created By, Created On and Property ID.

7.9.2 Add information to Generic Table

The following step-by-step walks you through how to add information to the generic table.

7.9 Step by Step 2 — Add information to Generic Table

1. Open Excel and log in.

2. Under the InEight tab in the Data section, select Table.
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3. Under Existing Table, select the name of your newly created Generic Table, and then select
Query All.

4. In the Identifier column or the Unique ID, fill in the data from the model.

The new information is then highlighted in yellow. This shows that the information has been
added or modified but not yet saved to the database table.

5. Under the InEight tab in the Settings section, click Pending Changes.

6. Click Publish.
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The database table is now updated.

7. Fill in any additional data throughout the project as needed.

7.9.3 Import information to Generic Table

The following step-by-step walks you through how to import information into the generic table.

7.9 Step by Step 3 — Import information to Generic Table

1. Open Excel and log in.

2. In Excel, select the spreadsheet tab containing the preferred data that needs to be uploaded into
a table.
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3. Under the InEight tab in the Data section, select Import.

4. In the Import Records dialog box, select the Table schema that you want to upload data into.

5. When a warning dialog box appears, select OK.

The Generic table opens with the new data added.

6. Under the InEight tab in the Settings section, select Pending Changes.

7. Click Publish.

The database table is now updated.

7.9.4 Refresh existing table data

Throughout the project, data might be updated by another user without notification that an update is
happening. You need to refresh your table to see new information.

The following step-by-step walks you through how to refresh existing table data.
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7.9 Step by Step 4 — Refresh existing table data

1. Open Excel and log in.

2. Under the InEight tab in the Data section, select Table.

3. Under Existing Table, select the name of your newly created Generic Table, and then select
Query All.

7.9.5 Close Database Tables

The following step-by-step walks you through how to close database tables.

Page 212 of 490 InEight Inc.  |  Release 23.10

7.9 Create Tables of External Data Model User Guide



7.9 Step by Step 5 — Close database tables

1. Open Excel and log in.

2. Right-click the Excel spreadsheet table tab.

3. Select Delete.

Deleting the table tab only removes the local worksheet from Excel, but it does not remove
database tables from your project.

You can also click the x in the top right of Excel. The InEight Excel Plugin dialog box opens
showing available options.
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Lesson 7 Review

1. How can you create Tags in InEight Model?

a. Manually create from Tags and Objects panel

b. Automatically create tags from the metadata of the Export / Import process

c. Manually import tags from an Excel file

d. All of the above

2. Tags are made up of what two components?

a. Category, Size

b. Size, Value

c. Value, Location

d. Category, Value

3. Deleting a tag that was created through the export / import process does not delete
the tag until the nexttime you export / import to revise or update your model.

a. True

b. False

Lesson 7 Summary

As a result of this lesson, you can:

l Create and edit static tags
l Create and edit dynamic tags
l Assign to and remove tags from objects
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LESSON 7 — DATA TRANSFORMATION
OPERATIONS

7.1 DATA TRANSFORMATION OPERATIONS (DTO)
OVERVIEW

DTOs provide flexible and repeatable processes to maintain, normalize, add, validate, parse, and
concatenate data. DTOs can be exported and imported from project to project to eliminate duplicate
effort.

You can access DTOs from the main InEight Model window. Click Logic > DTO.

The Data Transformation Operations window has three tabs:

l DTO – Lets you create a tree structure of DTOs.

l Selector - You can select model objects from tags and object properties using specific criteria.

l Action – Lets you create, parse, concatenate, and quantify model data, and more through
various functions.
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7.1.1 DTO tab

1 Action icons provide one-click actions for the most common DTO functions. You
can add, add group, export, import, duplicate, and delete.

2 The list view lets you enable or disable DTOs, create DTOs, and view the list
grouped by folders.

3 The log view shows the interaction information of DTOs when they are used. The
Maximize/Minimize icon opens or closes the DTO Log panel. You can use the
delete icon to clear the log.

4 Bottom action buttons let you run the selected DTOs or selected DTO groups, run
all enabled DTOs. Test your included model objects in the Selector tab criteria.

5 You can use the Expand Panels icon to view all three tabs at the same time or view
one tab at a time.
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7.1.2 Selector tab

Rule Type Select Tag or Object Property.

Tag/OP
Name

Select a Tag or OP Name

Operator Select the operator rule.

Value Select a value from the tag or object property identified in Tag / OP
Name field.

Exclude Exclude the children or parent model objects, or you can ignore using the
none value.

After you click the Test button, you can review and validate your selection criteria in the
Selection Information panel.
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7.1.3 Actions tab

Action Select between multiple action types that include Tag, Temp Property,
Calculated, Quantity, Elements, and Sequential Tags.
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Tag
Name

Enter a new unique tag name or select an existing tag name.

Tag
Value

Enter the new value that you want to associate to the Selector tab criteria.

The available fields change depending on the action you select.

7.2 CREATE A DTO

In the DTO tab, you can add DTOs manually. First you must create a DTO group, and then add DTOs to
the group. DTOs can also be imported and exported between projects to save you time.

7.2.1 DTO Tab

7.2.1.1 Add a DTO Group Folder

1. In the DTO tab, to Add a DTO group, click the Add Group icon.

2. You can add notes for the DTO group. Double-click the Notes section to add your notes.
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7.2.1.2 Add a DTO

1. Select a DTO group, and then click the Add DTO icon. You can also right-click in the DTO
group to add a DTO.

2. You can add notes for the DTO. Double-click in the Notes section to add your notes.

Page 220 of 490 InEight Inc.  |  Release 23.10

7.2 Create a DTO Model User Guide



7.2.1.3 Rename a DTO

You can rename DTO groups and DTOs to better communicate their purpose.

1. Click the DTO tab

2. Double-click the DTO Group or DTO, and then enter the new name. You can also right-
click the Name column and use the menu.

3. Click Save.

7.2.2 Selector Tab

After you create a DTO, you can create rules in the Selector tab to build your own criteria to find
specific model objects using their tags or object properties.

1. In the DTO tab, click your DTO to select it.

2. Click the Selector tab. You can see your DTO name as a reference. By default, a blank Rule row is
created.
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3. Fill in the rule information to identify all foundations in the model.

a. Rule Type

b. Tag / OP Name

c. Operation

d. Value

e. Exclude
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4. Click Test to select all objects that meet the criteria.

l After you click Test, you can review and validate your selection criteria in the Selection
Information panel.

5. You can add additional rules to filter for other metadata.
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a. Click the Add icon below the current rule.

b. Use the and/or toggle to switch between the two options. The ribbon changes color
depending on the option.

c. Fill in your rule criteria.

6. Click Test to select all objects that meet the criteria.

l You can review and validate that you have selected the objects as expected in the
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Selection Information panel.

7.2.3 Actions Tab

On the Actions tab, you can create a new tag.

1. Click the Actions tab. The action window shows the DTO name and by default, creates a blank
row for you to fill in.
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2. Fill in the criteria.

3. Enter the tag name and tab value.

l Click Run selected to execute the DTO and create your tag.

4. You can expand the DTO Log panel to view information about the executed DTO.

5. Click Save.
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1.1 DTO EXAMPLES

1.2 CLEAN UP AND NORMALIZE MODEL DATA

DTOs provide flexible and repeatable processes to clean up and normalize model data. Clean up and
normalizing data includes grouping the data from multiple models into a tag, grouping similar models
into a single tag, converting dimensional text data into a number, and converting lengths such as
inches to feet using tags and object properties.

For additional information on tags go to Tags and Objects.

The following are examples that will show you how you can use tags and object properties to clean up
and normalize data.

1.2.1 Group similar models into a tag

When you have multiple models in your project that have many differences, you can create tags that
combine similar models for easier and faster accessibility.

You can group models that contain Garage into a tag named Garage. Tags such as Office 1, Office 2,
and Garage can be used.

https://learn.ineight.com/Model/Content/11_Tags_and_Objects/0_TagsAndObjectsStart.htm


Add a DTO group and name it Normalize. In the group, add a DTO and name itModel Group – Garage.

In the Selector tab create the following rule criteria:
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Rule Type Tag

Tag / OP Name Model

Operator contains

Value Garage

Click the Test button to review and validate your selection criteria in the Selection Information
panel.

In the Actions tab use the following criteria:

Action Tag

Tag Name Model Group

Tag Value Garage
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Click the Run selected button to execute the DTO and create the new tag according to your
selection criteria. The results

will include Tags associated with your selection as shown in the screenshot below.

1.2.2 Convert dimensional text data into a number

If many of the models have dimensional data in text format, as opposed to a number format, you can
normalize this into something more standard.

The model has NPD (Nominal Pipe Diameter), whereas other design applications use size. This can be
normalized into something standard.
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Add a new DTO group in a new group or an existing group such as Normalize, and then name it Piping.
Add a new DTO in the group named NPD to Size_Pipe. You can add a note in the Notes column to
communicate the purpose of the DTO.

In the Selector tab use the following criteria:

Rule Type Tag

Tag / OP Name NPD

Operator not null

Click the Add row icon below the row to add another row. Add an additional rule that will filter
for Piping:

Rule Type Tag

InEight Inc.  |  Release 23.10 Page 231 of 490

Model User Guide 1.2 Clean up and normalize model data



Tag / OP Name NPD

Operator =

Value Piping

Click the and/or toggle above the first rule on the top left to select and. Selecting andmeans
that both rules must apply to

the model object data.

You can click the Test button to review and validate your selection criteria in the Selection
Information panel.
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In the Actions tab select Calculated for Action.

Click the Add row icon next to Action to add a new function, and then use the following criteria:

Function number()
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Tag NPD

Position 0

The number() function will convert the text data to number data.

Add another function, and then use the following criteria:

Function tag()

Tag IN8_Size_Pipe

IN8_Size_Pipe is a custom tag name. You can create and give your tag a specific name that will
help you organize your data.

In the DTO Log window, the Tag Name and Value shows the expected results after the DTO is
executed.
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Click the Run selected button to execute the DTO and create the new tag according to your
selection criteria.

1.2.3 Convert inches to feet

You can use DTOs to convert units. If you have models that have piping length in inches, and you need
to convert the length to feet for take-off, you can create a DTO to convert the units.

1.2.3.1 Convert text format to number format

Add a new DTO to convert the length of piping from text format to number format. Name the
new DTO Pipe Length (in).

In the Selector tab use the following criteria:

Rule Type Tag or Object Property

Tag / OP Name Length

Operator not null

Use the and/or group toggle at the top right to select and.

Click the Add group icon at the top right and include the following group criteria:

Rule Type Tag

Tag / OP Name Model

Operator =

Value Mec AG Yard Piping.nwd

Click the Add row icon on the bottom left, and then then use the following criteria:

Rule Type Tag

Tag / OP Name Model

Operator =

Value Mec UG Yard Piping_rev1.nwd

Use the and/or row toggle on the top left above the group rows to select or.
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The criteria selected will find all objects with a Length value. The and group toggle at the
top right means that both

listed model tag groups will be included.

In the Actions tab select Calculated for Action.

Click the Add icon next to Action to add a function, and then use the following criteria:

Function number()

Tag Length

Add another function with the following criteria:

Function tag()

Tag Length_Pipe (in)
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Click the Run selected button to execute the DTO and create the new tag according to
your selection criteria.

1.2.3.2 Convert piping length from inches to feet

Add a new DTO, and then name it Pipe Length (ft).

In the Selector tab create the following criteria:

Rule Type Tag

Tag / OP Name Length_Pipe (in)

Operator not null
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In the Actions tab select Calculated for Action.

Click the Add icon next to Action to add a function, and then use the following criteria:

Function math()

Tag Length_Pipe (in)

Operator /

Constant 12

Themath() function can be used with Tags, Object Properties, and Constants. Constant
will equal type in a number as opposed to using a tag.

Add another function with the following criteria:

Function tag()

Tag Length_Pipe (ft)
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Click the Run selected button to execute the DTO and create the new tag according to
your selection criteria.

1.3 IDENTIFY AND ADD ADDITIONAL MODEL DATA

DTOs provide flexible and repeatable processes to add additional model data. The following are
examples to show you processes to identify specific model data and add model data using DTOs.

1.3.1 Identify model data

You can differentiate between above ground large bore piping (AG/LB), above ground small bore
piping (AG/SB), underground large bore piping (UG/LB) and underground small bore piping (UG/SB).

1.3.1.1 Identify and use AG/LB Piping

You can add a DTO to find all large bore piping according to your standards (>2.5”). Also, create
a new tag named AG LB to

find all above ground piping.
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Add a new DTO, and then name it Pipe – AG LB.

In the Selector tab create the following criteria:

Rule Type Tag

Tag / OP Name Model

Operator =

Value Mec AG Yard Piping

Use the and/or row toggle on the top left to and.

Click the Add row icon below the row, and then use the following rule criteria:

Rule Type Tag

Tag / OP Name IN8_Size_Piping

Operator >

Value 2

In the Actions tab use the following criteria:

Action Tag
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Tag Name IN8_PipeAG/UG_LB/SB - PowerPlant

Tag Value AG LB

Click on the Run selected button to execute the DTO and create the new tag according
to your selection criteria.

1.3.1.2 Identify and use AG/SB

Add a new DTO to find all small bore piping according to your standards (<2”). Also, create a
new tag named AG SB to find

all above ground piping.

Duplicate the previous DTO, and then rename the new DTO Pipe – AG SB.

In the Selector tab update the following criteria:

Operator <

Value 2.5

Leave the rest of the criteria the same.

InEight Inc.  |  Release 23.10 Page 241 of 490

Model User Guide 1.3 Identify and add additional model data



In the Actions tab update the Tag Value to AG SB. Leave the rest of the criteria the same.

Action Tag

Tag Name Model Group

Tag Value Office_1

Click on the Run selected button to execute the DTO, and then create the new tag
according to your selection

criteria.
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1.3.2 Add weight to steel members using length

If your model includes the steel members length but does not have the weight, you can calculate the
length into weight for take-off.

Add a new DTO, and then name itW Shapes in LBs.

In the Selector tab create the following new rule criteria:

Rule Type Tag

Tag / OP Name Revit_Family_Type

Operator contains

Value W Shape

Use the and/or row toggle on the top left to select and.

Click the Add row icon on the bottom left, and then use the following criteria:

Rule Type Tag

Tag / OP Name Length

Operator not null

Value W Shape

In the Actions tab select Calculated for Action.
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Click the Add icon next to Action to add a function with the following criteria, assuming 90 lbs.
per foot:

Function math()

Constant 90

Operator *

Tag Length

Themath() function can be used with Tags, Object Properties, and Constants. Constant
will equal type in a number as opposed to using a tag.

Add another function with the following criteria:

Function Tag()

Tag name Calculated Nominal Weight (lbs)

Click the Run selected button to execute the DTO and create the new tag according to your
selection criteria.
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1.3.2.3 Convert weight from pounds to tons

Now that the previous DTO calculates the length of your steel members into weight in pounds,
you need to calculate the

weight into tons for take-off.

Duplicate the previous DTO, and then name the new DTOWeight (ton).

In the Selector tab create the following new rule criteria:

Rule Type Tag

Tag / OP Name Calculated Nominal Weight (lbs)

Operator not null

In the Actions tab select Calculated for Action.

Click the Add icon next to Action to add a function with the following criteria:

Function math()

Tag Calculated Nominal Weight (lbs)

Operator /

Constant 2000

Add another function with the following criteria:
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Function Tag()

Tag name Weight (ton)

Click the Run selected button to execute the DTO and create the new tag according to
your selection criteria.

1.4 CONCATENATE MODEL DATA

Data Transformation Operations (DTOs) provide flexible and repeatable processes to concatenate
model data. In the following examples you will see how you can concatenate model data using DTOs.

Data structured in models that you receive do not always provide data in a way that you can use. You
need to concatenate data to create unique tags.

1.4.1 Make unique tag values for multiple objects

Add a new DTO, and then name it Spool Number.

In the Selector tab use the following criteria:
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Rule Type Tag

Tag / OP Name Pipeline

Operator contains

Value RWS

Use the and/or row toggle on the top left to select and.

Click on the Add row icon on the bottom left to create a new row, and then use the following
criteria:

Rule Type Tag

Tag / OP Name 00-CWA

Operator not null

In the Actions tab select Calculated for Action.

Click the Add icon next to Action to add a function, and then use the following criteria:

Function text()

Tag Name 00-CWA

Add additional rows, and then create a series of functions using dash as a constant as shown:
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Function text()

Tag Name -

Function text()

Tag Name IN8_System - PowerPlant

Function text()

Tag Name -

Function text()

Tag Name IN8_LineNumber - PowerPlant

Function text()

Tag Name -

Function text()

Tag Name -01

Function tag()

Tag Name IN8_SpoolNumber
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Click on the Run selected button to execute the DTO and create the new tag according to your
selection criteria.

1.5 PARSE MODEL DATA

Data Transformation Operations (DTOs) provide flexible and repeatable processes to parse model data.
An example is if your project systems are concatenated into other metadata, you can parse it to its
own tag. In the following example you will see how you can parse model data using DTOs.

1.5.1 Parse system information

If your project systems are concatenated into other metadata, you should parse it to its own tag to
easily access the model by systems.

Add a DTO, and then name it Systems – Piping.
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In the Selector tab use the following criteria:

Rule Type Tag

Tag / OP Name Pipeline

Operator not null

Use the and/or group toggle at the top right to select and.

Click the Add group icon at the top right, and then include the following group criteria:

Rule Type Tag

Tag / OP Name Model

Operator =

Value Mec AG Yard Piping.nwd

Click the Add row icon below the row to add another row, and then use the following criteria:

Rule Type Tag

Tag / OP Name Model

Operator =

Value Mec UG Yard Piping_rev1.nwd

Use the and/or row toggle above the grouped rows on the top left and select or.
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The selected criteria will find all objects with a Pipeline value. When you use the and group
toggle, it will select the objects

from the listed model tag values.

Click the Test button to review and validate your selection criteria in the Selection Information
panel. Results should

include AQ-00074001and CWR-00064101.

In the Actions tab select Calculated for Action.

Click the Add icon next to Action to add a new function, and then use the following criteria:

Function substr()

Tag Pipeline

Index of -

Offset 1

Length -3

The substr() function lets you parse out your selected characters within a string of
characters.
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The Index of field can be blank, or you can enter any character from where you want to
start indexing. This example starts at the dash value in this string of characters for AQ-
00074001.

Add another function with the following criteria:

Function tag()

Tag IN8_System

Click on the Run selected button to execute the DTO, and then create the new tag according to
your selection criteria.
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1.6 QUANTIFY MODEL DATA

Data Transformation Operations (DTOs) provide flexible and repeatable processes to quantify model
data. In the following examples you will see how you can quantify model data using DTOs.

The InEight Model to InEight Estimate integration is the most efficient way to get quantities from a
model into an estimate. SeeModel-Based Takeoff Overview andModel to Estimate integration.
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The following examples do not use the InEight Estimate integration.

1.6.1 Extract quantities from model

You can sum up quantities from your model to use for estimating or tracking subs by installed
quantities.

1.6.1.1 Quantities by Count

You can add a DTO to find specific model objects to sum up their quantities, and then utilize the
Quantity action type to

sum the quantities by count.

Add a DTO, and then name it Foundation Pier.

In the Selector tab create the following rule criteria:

Rule Type Tag

Tag / OP Name 02 - Construction Levels

Operator =

Value G-Foundations

Exclude children

Click on the Add row icon on the boottom left, and then use the following criteria:

Rule Type Tag

Tag / OP Name 80 - Construction Items

Operator =

Value Drilled Pier

Use the and/or row toggle on the top left to select and.

When you use the and toggle, it means that both rules must apply to model object data.
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In the Actions tab use the following criteria:

Action Quantity

Quantity Type count

Code FND PEIR

Units Items

Description Foundation Pier

You can give the Code and Description fields your own custom input to help
organize the data.

Click the Equals icon to see your quantities. You can also use the Operation and Value
fields to adjust your

quantities, and then click the Equals icon to see your updated quantities.
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Click the Run selected button to execute the DTO and create the new tag according to
your selection criteria.

1.6.1.2 Quantities by area

Add a DTO to find specific model object to sum up their quantities and then utilize the Quantity
action type to sum the

quantities by area.

Add a DTO, and then name it Foundation Pier.

In the Selector tab create the following rule criteria:

Rule Type Tag

Tag / OP Name 02 - Construction Levels

Operator =

Value G-Foundations

Use the and/or toggle at the top left to select and.

Click the Add icon on the bottom left, and then add the following criteria:
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Rule Type Tag

Tag / OP Name 80 - Construction Items

Operator =

Value Drilled Pier

Exclude children

In the Actions tab use the following criteria:

Action Quantity

Quantity Type sum area

Code FND PEIR

Units square feet

Description Foundation Pier

Click the Equals icon to see your quantities. You can also use the Operation and Value
fields to adjust your

quantities, and then click on the Equals icon to see your updated quantities.
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Click the Run selected button to execute the DTO and create the new tag according to your
selection criteria.

1.6.1.3 Quantities by volume

You can add a DTO to find specific model object to sum up their quantities and then use the
Quantity action type to sum up

the quantities by volume.

Add a DTO, and then name it Foundation Pier.

In the Selector tab create the following rule criteria:

Rule Type Tag

Tag / OP Name 02 - Construction Levels

Operator =

Value G-Foundations

Use the and/or row toggle at the top left to select and.

Click the Add row icon on the bottom left, and then add the following criteria:
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Rule Type Tag

Tag / OP Name 80 - Construction Levels

Operator =

Value Drilled Pier

Exclude children

In the Actions tab use the following criteria:

Action Quantity

Quantity Type sum volume

Code FND PEIR

Units cubic yards

Description Foundation Pier

Click the Equals icon to see your quantities. You can also use the Operation and Value
fields to adjust your

quantities, and then click the Equals icon to see your updated quantities.
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Click the Run selected button to execute the DTO and create the new tag according to
your selection criteria.

1.6.1.4 Quantities by tag

You can add a DTO to find specific model object to sum up the quantities and then utilize the
Quantity action type to sum

up the quantities using a tag.

Add a DTO, and then name it Foundation Pier.

In the Selector tab create the following rule criteria:

Rule Type Tag

Tag / OP Name 02 - Construction Levels

Operator =

Value G-Foundations

Exclude children

Use the and/or row toggle at the top left to select and.

Click the Add row icon on the bottom left, and then add the following criteria:
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Rule Type Tag

Tag / OP Name 80 - Construction Levels

Operator =

Value Drilled Pier

Exclude children

In the Actions tab use the following criteria:

Action Quantity

Quantity Type sum property

Tag IN8_Area (sf)

Code FND PEIR

Description Foundation Pier

Click the Equals icon to see your quantities. You can also use the Operation and Value
fields to adjust the quantities,

and then click the Equals icon to see updated quantities.

Click the Run selected button to execute the DTO and create the new tag according to
your selection criteria.
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1.6.1.5 Access quantities via Excel

Model has a plugin for Microsoft Excel to access model quantities. To download the Excel Plugin
Installer go to

InEight Downloads.

After you install the plugin, the InEight menu will show in the top menu ribbon of Excel.

Model and Excel interact with each other without the need to have the Excel application open.
However, the data created

using quantity DTOs uses tables. You must be logged in to Model via Excel to access the table
data.

When you click on the InEight tab in Excel, you can log in using the same credentials you use for
Model.

Click Table-> admin-> config-> DTO-> DTO Estimate Record-> Query All.

The results of the Quantity DTOs executed in Model will show.
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1.7 VALIDATE MODEL DATA

Data Transformation Operations (DTOs) provide flexible and repeatable processes to validate model
data. In the following examples you will see how you can find model objects that do not have certain
values or validate specific model data format. This information can be used to communicate any model
data that does not meet project requirements.

1.7.1 Validate model data is compliant

You can validate that specific model data meets your project requirements.

1.7.1.1 Validate specific model data exists

You can find model objects that do not have certain values, such as length.

Add a new DTO, and then name itW Shapes have no LENGTH

In the Selector tab use the following criteria:

Rule Type Tag

Tag / OP Name Revit_Family_Type

Operator contains
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Value W Shape

Use the and/or row toggle on the top left and change it to and.

Click the Add row icon under the row, and then use the following criteria:

Rule Type Tag

Tag / OP Name Length

Operator is null

Click the Actions tab, and then use the following criteria:

Action Tag

Tag Name 99 - Validation Issue

Tag Value No Length
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Click the Run selected button to execute the DTO and create the new tag according to
your selection criteria.

1.7.1.2 Validate model data for specific format

You can validate that your Pipeline data has the system prefix followed by a dash, such as AQ-
0001065.

First add a DTO to tag to all relevant data as invalid, and then create another DTO to find
validated data. The purpose is to place the invalid and valid tag values in the same tag name.
When you use the same tag name, the invalid data will switch to validated because an object
can only have one value in a tag name.

You must run both DTOs at the same time, and in the correct order in the list. First run invalid
data, and then validated

data.

Add a new DTO group, and then name it Validation. Add a new DTO in the group for all Pipeline
data that will be tagged as invalid data, and then name it Pipeline – Invalid.
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In the Selector tab create the following criteria:

Rule Type Tag

Tag / OP Name Pipeline

Operator not null

In the Actions tab use the following criteria:
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Action Tag

Tag Name IN8_Validation - PowerPlant

Tag Value Pipeline - Invalid

Click the Run selected button to execute the DTO and create the new tag according to
your selection criteria.

Add another DTO in the group for all Pipeline data that will be tagged as valid data, and then
name the new DTO

Pipeline – standard layout.

In the Selector tab create rule criteria to find all piping systems followed by a dash.

Rule Type Tag

Tag / OP Name Pipeline

Operator contains

Value List AQ- through WW-

Exclude none

Use the and/or row toggle on the top left to select or.

Click the Add row icon on the bottom left to add new rows, and then include all your
values.
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In the Actions tab use the following criteria:

Action Tag

Tag Name Tag = IN8_Validation

Tag Value Pipeline - Validated

Page 268 of 490 InEight Inc.  |  Release 23.10

1.7 Validate Model Data Model User Guide



Click on the Run selected button to execute the DTO and create the new tag according
to your selection criteria.
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LESSON 2 — STYLES

Lesson Duration: 40 minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Create and manage styles
l Create and manage style sets
l Apply styles to tags
l Assign styles using Excel

Topics in this Lesson



2.1 STYLING OVERVIEW

Materials and colors are not fixed, or assigned universally to all model objects, like they are in other
modeling environments. You have the flexibility to view the model in the way that makes sense for
yourself. In Model, you need to remember:

l Styles are the materials or colors in Model

l Style Sets are collections of assigned Styles

Styles allow you to switch between Style Sets to change the way you visualize the model. For example,
creating a Style Set that emphasizes a system, such as HVAC, or a Style Set that has the colors to
conform to an owner’s requirements. With these visually highlighted, it helps to identify those areas
which you want to focus on when looking at the model.

The Styling panel allows the manipulation of the appearance (surface and line, color and transparency)
of geometry. There are two tabs in the Style panel: Styles and Style Sets.

2.1.1 Launch Styling Menu

To access the Styling panel, select View > Styling.
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l This will open the Styling window.

2.2 CREATE AND MANAGE STYLE SETS

There are predefined style sets grouped under Basic when a project is created. New style sets can be
created to represent real-world material characters such as glass and steel, or simple colors, to
represent different disciplines or systems.

The predefined style sets cannot be edited. They can be duplicated to create new,
custom style sets.
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2.2 Step by Step 1 — Create a Style Set

1. Select Add.

l The New Style Set dialog box will open

2. Type in a desired name for your new style set (i.e. Major Systems).
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3. Click OK.
l The new style set will be grouped under the project name

4. Select the style set to make it active.
l Any styles applied will be a part of the active style set

2.2 Step by Step 2 — Edit a Style Set

Once one or more styles have been applied to a style set, the style set can be managed.
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1. Select a style set.
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2. Select Edit.
l The Edit Style Set dialog box will open

l To remove a style, click the red X.
l To reorder styles, drag a style up or down within the list.

When multiple style assignments apply to an object or tag, those higher in
the list take precedence.

3. When finished, select OK.

Page 278 of 490 InEight Inc.  |  Release 23.10

2.2 Create and Manage Style Sets Model User Guide



2.2 Step by Step 3 — Delete a Style Set

1. Select a style set, then click the Delete icon.
l Or, right click on the style set, then select Delete Selected Style Set

2.3 CREATE AND EDIT STYLES

There are predefined styles, which cannot be modified, but can be duplicated to create a new style. All
newly created styles will be grouped under the project name.
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2.3 Step by Step 1 — Create a New Style

1. Select the Styles tab and then select Add.

l The Edit Style window will open
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2. Click Choose Line Color... .
l Or toggle the Enabled box to have no outline color

l The Select Color dialog box will open

3. Select your desired color and click OK.
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4. Change the line thickness as desired.
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5. Click Choose Line Color.

l The Select Fill Color dialog box will open

6. Select you desired color and set an opacity if desired, then click OK.
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7. Select Save As… to save as a new style (i.e. Glass – Transparent).
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l The new styles will be grouped under the project name
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2.3 Step by Step 2 — Edit a Style

1. Select a Style Set, then click the Edit icon.
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2.3 Step by Step 3 — Set a Style as a Default

1. Select a style, then right click and select Make default for selected StyleSet.

Once Styles are assigned, then any style can be identified as the default (i.e.
Transparancy).
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2.3 Step by Step 4 — Delete a Style

1. Select a style, then click the Delete icon.
l Or, right click on the style set, then select Delete Selected Style

2.4 APPLY STYLES TO TAGS

Styles are appearance definitions. Assigning a style to a tag will change the appearance of model
objects with that tag. When a Style Set is active, it will be denoted at the top of the Styling panel.
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Styles can be applied to objects or tags; however, it is always preferable to use tags
whenever possible as this provides greater flexibility.

If a style was applied to an object and that object was removed and redrawn within the
design software, then that object will no longer be assigned the style.

2.4 Step by Step 1 — Apply a Style to a Tag

1. Select a tag withing the Tags panel.
l This will select model objects

2. Withing the Styles tab, select a style, then click Assign.
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l Or, drag and drop a style on top of a tag

l This method will not select model objects

2.5 ASSIGN STYLES USING EXCEL

Before beginning, ensure you have only one instance of InEight Model and one instance of Excel open.
Matching unique tag category and values need to be in the model and in Excel.

Within the Tags and Objects menu, identify a Category Name and its values. For this example, the Tag
Category will be Material and the Values are also shown as Glass, Metal and Stone.
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In Excel, type the tag and object names into the first cell on the Excel sheet.

Now that there is a unique tag category with values within excel that match the model, a style set can
be pushed from excel into the model.

2.5 Step by Step 1 — Color Excel Cells

1. Add color to the cells.

2. Within the Excel menu bar, select the InEight tab.
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3. Within the Visual Reporting section:
l Set ID Tag: click on a cell within the Tag Category, then select Set ID Tag.
l Set Color: click on a cell that has the color identified, then select Set Color.

4. In this case, the Set ID Tag and Set Color happen to be in the same column of Material. To
push these colors into the model and create a new style set, select Show in Model.
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l Your project in Model will reflect the colors selected for those objects. Once Show in
Model is executed, a new style set is created within the Styles Sets tab under Visual
Reports

This style will not be saved with the project in this state.

5. To save this style set with the project, right click on the style set and select Duplicate
Selected Style Set.
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l This new Style Set will appear under the project name

All model objects that were not affected by the defined color receive a
transparency.
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2.6 STYLE LEGEND

The Style legend option provides visibility into the color definitions applied to the geometry. You can
easily communicate the information to all project stakeholders.

You can open the Styling legend in View > Style Legend.

The Style Legend window opens and shows the style name, tag name, and tag value associations that
are included in the selected style set.
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The window automatically refreshes after you make a change to the active style set.

A selected Percent complete style set shows the percent complete for each element style color.

This provides the visibility of the status of each element, so you have the data to plan accordingly.
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Lesson 2 Review

1. InEight Model offers basic, pre-defined styles.

a. True

b. False

2. When creating a new style, what two features can you set?

a. Line color, fill color

b. Fill color, shadow

c. Shadow, line color

d. None of the above

3. You can only apply a style at the project level.

a. True

b. False

Lesson 2 Summary

As a result of this lesson, you can:

l Create and manage styles
l Create and manage style sets
l Apply styles to tags
l Assign styles using Excel
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LESSON 3 — MASTER PRESETS

Lesson Duration: 30 Minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Create and edit master presets
l Group master presets
l Share master presets

Topics in this Lesson



3.1 MASTER PRESETS OVERVIEW

Create a master preset to capture and save the context or state of your project through a filtered lens
or camera angle. Navigate between master presets to help you effectively manage your model and
share your perspective with other users.

Master presets are created on a project level. Once created, anyone can use or edit your
master presets.

3.1.1 Master Preset Editor

From an open model(s), navigate to the view that you want to save as a master preset. When ready to
capture that viewpoint, navigate to View and selectMaster Presets. Then, select Add and select your
preset preferences.

l Model Visibility shows models that are visible and in-view
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Once selected, Model Visibility will not show any new model streams that may be added
to the project. To set or adjust model visibility settings, open the Object panel or right
click menu to view the show/hide and selection options.

l Selected Objects shows any objects you have selected on the model

l Style Set shows any styles already assigned to the visible objects of your model

l Object Visibility saves the objects’ states so that any objects already hidden remain hidden

l Workspace saves the user interface configuration, their location, and current screen resolution

Selecting Workspace may cause undesirable results for users with different screen
resolutions and configurations. Avoid selecting the Workspace when working in a shared
preset.

When a custom Workspace is necessary, create and label a folder in your master preset
panel where you can save that preset. Add your Workspace selection (and parameters, if
possible) to the master preset description.

l Camera saves the current camera settings (i.e. the camera’s position in space, direction,
and depth of view)

l Archive saves any open documents in the Archive Library

Using Archive, you can bookmark pages within a document so that users open to a
specific page while viewing the project from your master preset.

l Sectioning shows any planes or sections of your model(s) that are visible

l Measurements shows selected measurements graphically or visually

l Camera Transition Time, with the Camera option selected, allows you to adjust the speed of the
camera’s transition time. The default Camera Transition Time is 1,000 milliseconds

If Camera is not selected, you cannot adjust the Camera Transition Time.

3.1.2 Reset Workspace

If a master preset has messed up your workspace, you can reset your workspace by going to the
Settings and selecting Reset Workspace.
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3.1.3 Right Click Menu Features

Quickly access additional master preset options by right clicking within the Master Preset panel.

l Edit and Update Selected … opens the Master Preset Editor so you can quickly make and save
changes to a preset for the selected assets

l Update Select w/ Current Values updates a Master Preset with the current model view
configuration without opening the Master Preset Editor

l Set as Project Default will make the selected master preset the default view (of the project you
have open) anytime you load that project

l Copy URL to Clipboard copies the master preset of your project to share with other
collaborators

l Delete Selected deletes any selected master preset(s)

l Add Group … allows you to add a group from the right click menu

l Rename Group … allows you to rename a group from the right click menu

l Delete Group deletes any selected group(s)

l Expand All shows all folders in the master preset panel

l Collapse All collapses all folders in the master preset panel

l Export as Viewpoints allows you to create an XML file that you can import into Navisworks. In
other words, you can share your viewpoint (including any presets you have, the order of those
presets, and your spatial view of the model) with others through Navisworks
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3.2 CREATE AND MANAGE MASTER PRESETS

3.2 Step by Step 1 — Creating a Master Preset

1. Select Add to create a new preset.

l The Master Preset Editor will open

2. Name your master preset.
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It is good practice to create one or more HOME master presets.

3. Next, check the filter selections you would like to apply to this preset.

Mouse over settings for tool tips.

4. Add a description to help others who use this preset to know what view of the project they
are seeing and why (optional).

5. When finished, select OK.

The description text does not wrap, so it is best practice to keep the description
short.

3.2.1 Master preset object visibility maximum dialog box

This is a rare notification that you could encounter when you are trying to Hide Unselected while you
are also selecting the Object Visibility option when creating the Master Preset.

You can also get that dialog box if you published one entire model from Navisworks.
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It is recommended that you publish discipline specific models or area specific models. Then select
objects, RMC, and select Hide Models from Unselected. Then RMC and select Hide Unselected. After
that, create the Master Preset with Object Visibility option.
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3.2 Step by Step 2 — Editing a Master Preset

1. Select the master preset that you want to modify and select the Edit icon.

l The Master Preset editor will open
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2. Make your changes and select OK.

3.2 Step by Step 3 — Editing a Master Preset - Model View

1. Prepare your model view.

2. Select a master preset and click the Edit icon. Then, select OK.
l Or, right click on a master preset, then select Update Selected w/Current
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Settings
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3.2 Step by Step 4 — Deleting a Master Preset

1. Select the master preset that you want to remove and select the Delete icon.

3.3 ORGANIZE MASTER PRESETS

Organize master presets into contextual groups to distinguish between executive-level, task-specific,
team-specific views. Drag and drop master presets and groups within the Master Preset panel to
create comprehensive organization.
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3.3 Step by Step 1 — Grouping Master Presets

1. Select the Group icon and enter a group name. Then select OK.
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2. Now, you can add presets to this group.
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Notice, you cannot drag and drop a group above the project name. That’s because
groups are created under the parent project.

3.3 Step by Step 2 — Set a Master Preset as the Project Default

A master preset can be set as the project default so that when a project loads the model view is set to
the default master preset.
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1. Right click on a master preset, then select Set as project default.

3.4 SHARE AND EXPORT MASTER PRESETS

Quickly communicate by sharing a master preset with other project collaborators. Add emphasis or
clarity by assigning colorful style sets and tags to your master preset. Or, use master presets to check
project progress or review changes by comparing the captured viewpoint against its archived state in
the Project History folder (View > Project History).
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3.4 Step by Step 1 — Sharing a Master Preset

1. Select and right click on the master preset that you want to share. Select Copy URL to
Clipboard.

l You can now paste your preset URL to an email, message, or other means of
communication.
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3.4 Step by Step 2 — Exporting Master Presets

1. Right click on a master preset, then select Export as Viewpoints.
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Lesson 3 Review

1. Master presets can help you to...

a. configure a custom workspace.

b. create profiles or filters of your model to convey specific information.

c. All of the above

d. None of the above

2. From the Master Preset Editor, selecting _____________ will show any planes of
your model that are visible.

a. Measurements

b. Sectioning

c. Archive

d. Model Visibility

3. Only project administrators can group or share presets.

a. True

b. False

Lesson 3 Summary

l Create and edit master presets
l Group master presets
l Share master presets
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LESSON 4 — COORDINATION - CLASH
MANAGER

Lesson Duration: 20 Minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Create and manage a coordination rule
l Create and manage coordination rule groups
l Define clearance settings

Topics in this Lesson



4.1 CLASH MANAGER OVERVIEW

Coordination is the process of using rules to identify hard and soft clashes, creating grouped clashes
into trackable issues, and assigning them to users or user groups to resolve.

Clash Manager rules are flexible rules established to detect clashes between model objects by
examining geometric relationships between tags. Clash manager rule groups can be created to
organize rules and to quickly execute multiple rules at the same time.

The Clash Manager results tab shows the clashes detected after running a rule.
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4.2 CREATE AND MANAGE COORDINATION RULES

Coordination rules are triggers from tags. In Clash Manager, rules are created to fine-tune the
workload and the focus of the coordination.

A best practice is to create discipline focused rules. For example, when you clash piping/plumbing
versus steel, then make the piping/plumbing your primary tag and steel your secondary tag. This type
of rule groups related steel clashes to a single piping/plumbing clash.

4.2.1 Considerations

Admin and Standard users can create coordination rules. Read-only users can also create coordination
rules but cannot save any actions to the project.

Rules that are linked to issues are locked and cannot be modified.

4.2.2 Steps

To open the Clash manager, go to Logic > Clash Manager.
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Create a coordination rule

1. In the Rules tab, click the Add icon. The Rule definition dialog box shows.

2. Enter a name in the Title field.

3. Select a Primary Tag Name and Primary Tag Value.

4. Select a Secondary Tag Name and Secondary Tag Value.

5. Add Tolerance Settings as needed. For more information, see Tolerance Settings.

6. Select the Include Objects From Same Model Stream checkbox if your primary and secondary
tags are within the same model stream.

Page 324 of 490 InEight Inc.  |  Release 23.10

4.2 Create and Manage Coordination Rules Model User Guide



InEight Inc.  |  Release 23.10 Page 325 of 490

Model User Guide 4.2 Create and Manage Coordination Rules



Edit a coordination rule

1. Select a rule from the list.

2. Click the Edit icon. The Rule definition dialog box opens.

3. Make your rule definition changes in the Rule Definition dialog box.

4. Click the Save Rule Definition button.
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To view the Rules and Results tab side-by-side, click the Expand icon at the bottom left of the panel.

Export rules

1. Click the Export icon.

2. Select Export All Rules… or Export Selected Rules.... The export file is saved in a .cr file extension
in xml format.

Import rules

1. Click the Import icon.

2. Select the file to import, and then click the Import button.
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When importing, the tags identified in the rules are created as tags in the project if
they do not already exist.

4.3 TOLERANCE SETTINGS

Tolerance settings are used to define minimum clash tolerances or tolerance zone requirements
around objects. You can isolate an object, and then preview the selected object to visualize and
experiment with these settings.

The following table is a list of the available tolerance settings:

Setting Description

None Used to detect any geometric intersection.

Expand

Expands the geometry in all directions by the defined value.
l Use a negative number to require a minimum Clash Tolerance. Negative a
tenth of an inch will require a collision of a tenth of an inch or more before
listing it as a Clash.

l Use a positive number to establish a clearance zone around the object.
Positive one foot will list any geometry within a foot of the object as a Clash.

Sphere Establishes a spherical Clash Tolerance or Clearance Zone.

Cylinder Establishes a cylindrical Clash Tolerance or Clearance Zone.
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4.3.1 Steps

You must first select an object. The object selected represents all objects with the same
Primary or Secondary Tag Value selected.

Create rules for Expand, Sphere, and Cylinder tolerance settings

1. Fill in the Rule definition fields to create a rule.

2. Select Expand for Tolerance Settings.

3. Select the Preview on Selected Object checkbox.

4. Select a Unit from the drop-down list.

5. Enter a value in the Value field.
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You can follow the same steps for Sphere and Cylinder tolerance settings as shown in the images
below:

Sphere
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Cylinder
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4.4 CREATE AND INTERROGATE CLASH RESULTS

In Clash Manager you can run clash rules or rule groups to get clash results. The clash results can then
be reviewed and interrogated. To open Clash Manager, go to Logic > Clash Manager.

A best practice is to use a master preset to focus on a specific area of the federated
discipline models before running a rule to review focused clash results.

4.4.1 Considerations

Admin and Standard users can create coordination rules. Read-only users can also create coordination
rules but cannot save any actions to the project.
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4.4.2 Steps

Create clash results

1. In the Clash Manager Rules tab, select a rule or rule group, and then click the Run rule icon.

The Results tab will open and show the clash results grouped by the primary tag selected in the
rule creation.
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2. In the Results tab, select a clash result, and then select a tag in the Select Tag Name drop-down
to view additional insight of the clash results.

3. To view a heatmap of results, click the Clash results settings icon to enable Issued Result and
Clash Points.
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4. Click the Select all clash results icon at the top left to group and view additional related clashes
to group into a single issue.

5. Click the Clear the results list icon to clear and deselect clash results.

To view the Rules and Results tab side-by-side, click the Expand icon at the bottom left of the panel.
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4.5 CREATE AND MANAGE COORDINATION RULE
GROUPS

Coordination rules can be run individually or as groups in the Clash Manager Rules panel. Coordination
rule groups let you run all rules that are relevant to a scope item at the same time. Rule grouping is
helpful when the project's overall scope is divided across the project team.

A best practice is to create discipline focused rules. For example, when you clash piping/plumbing
versus steel, then make the piping/plumbing your primary tag and steel your secondary tag. This type
of rule groups related steel clashes to a single piping/plumbing clash.

4.5.1 Considerations

Admin and Standard users can create coordination rules. Read-only users can also create coordination
rules but cannot save any actions to the project.

4.5.2 Steps

To open Clash Manager, go to Logic > Clash Manager.
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Create a coordination rule group

1. In the Rules tab, click the Add Group folder icon in the Groups section, and then enter the group
name.

2. Click the new group folder, and then click Add folder to create a sub-folder.

3. Select one or more rules, select a Group folder, and then click the Add to Group button.

To view the Rules and Results tab side-by-side, click the Expand icon at the bottom left of the panel.
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Export rules groups

1. Click the Export icon.

2. Select Export All Groups... or Export Selected Groups.... The export file is saved in a .cr file
extension in xml format.
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4.6 SHOW DUPLICATE OBJECTS

The Show Duplicate Objects option lets you perform duplicate checking operations in the aggregated
Model environment.

Based on the data reported using the show duplicate option, the design team can remove duplicate
object geometry from the authoring environment.

To see a list of duplicate objects, run the report in Logic > Show Duplicate Objects.

A new window opens that shows grouped duplicate objects and provides the source file information so
you can remove the duplicated geometry at the source.
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4.6.0.1 Export duplicate objects

You can export and view the data in an Excel file. Click the Export icon at the bottom right to start the
export.

The default export file type is .csv.

The exported duplicate objects file can be imported to the archive library and attached to issues. You
can then export them to a BCF export for the engineering team to review.
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Lesson 4 Review

1. ___________ are created to detect clashes.

a. Styles

b. Tags

c. Coordination Rules

d. None of the above

2. Coordination rules can only be run individually.

a. True

b. False

3. ___________ define the parameters around objects for clash detection.

a. Clearance settings

b. Coordination issues

c. Coordination rules

d. None of the above

Lesson 4 Summary

As a result of this lesson, you can:

l Create and manage a coordination rule
l Create and manage coordination rule groups
l Define clearance settings
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LESSON 5 — COORDINATION - ISSUE
MANAGER

Lesson Duration: 60 minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Create clash results
l Create and manage coordination issues
l Find nearby clashes and add clashes to an existing issue
l Create and manage coordination results

Topics in this Lesson



5.1 ISSUE MANAGER OVERVIEW

Issue Manager lets you turn geometric clash issues, model review, and site-walk findings into issues.
Issues can be grouped and then assigned and tracked all the way to completion.

The Issue Manager contains 3 tabs:

l Issues – View the list of issues grouped in folders.

l Details - Lets you add additional information such as status, assignee, set location pins,
resolution information, add additional views, attachments, and markups.

l Summary - Shows all clashes associated with the issue.

To view all tabs side-by-side, click the Expand icon at the bottom left of the panel.
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5.2 CREATE AND MANAGE COORDINATION ISSUES

Coordination issues are groupings of geometric clashes, viewpoints, documents, and markups that can
be assigned to a user or a user group. You can create coordination issues without a geometric clash. All
issues created can be exported.

5.2.1 Considerations

When creating and managing issues, one best practice is to have the Clash Manager’s Results panel
and Issue Manager panel open side-by-side. After you run a clash rule or rule group, your focus will be
on their results in the Clash Manager’s Results tab and the Issue Manager.

5.2.2 Steps

To open the Clash or Issue Manager, go to Logic > Clash Manager or Issue Manager.

Add folders and sub-folders to organize issues

1. In Issue Manager, to add a new folder, click the Add folder icon, and then name the folder.

2. To add sub-folders, select a folder, and then click Add folder icon.

Create a non-geometric clash issue

1. Select a folder, and then click the Add issue icon. A new issue is created, and the Details panel
opens to fill in the issue details.
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Create a coordination issue from clash results

1. Open the Clash Manager and the Issue Manager’s panels side-by-side.

2. In Clash Manager, run a rule or rule group.

3. In Issue Manger, select or create a folder to push the clash results into.

4. Select a clash result, and then in the viewer, zoom into the result.

5. Right-click the clash result, and then select New Issue from selected result or Add selected
results to current Issue. The Details tab shows.

In the Details tab you can view and manage thumbnails, clashes, status, summary, views,
attachments, and markups. For more information about the Details panel, see Details panel
overview.

Page 346 of 490 InEight Inc.  |  Release 23.10

5.2 Create and Manage Coordination Issues Model User Guide



InEight Inc.  |  Release 23.10 Page 347 of 490

Model User Guide 5.2 Create and Manage Coordination Issues



To view the all tabs side-by-side in Issue Manager, click the Expand icon at the bottom left.

When you create an issue offline, the issue ID number shows as a GUID. An issue ID
number is assigned the next time you are online.

Add markup

1. In the Details panel, under Attachments and Markups, click the Add button. A New Markup tab
opens in the viewer window.

2. Markup the view using the markup tools.

You can edit the size of the text by highlighting the text and then using the
Thickness bar.

3. To save the markup, click Save to..., and then you can select Issue... or File....When saving to
Issue, it saves the markup to the issue. When saving to File, it saves the markup to a PDF file.

4. Click the Back to Model button to go back to the viewer.

5. To close the markup view, click the Close icon at the far right.

Edit an issue

1. Select an issue, and then click the Edit issue icon. The issue opens in the Details panel.

You can view and edit thumbnails, pins, clashes, status, assignee, priority, due date, summary,
views, attachments, and markups.
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2. Select Clashes to view all clashes in the issue. You can edit active clashes and change to Ignore or
Resolved. When all the clashes are set to Ignored or Resolved, the issue status automatically
shows as Resolved.

When an issue is in Resolved status, the coordinator responsible should visually
inspect the issue to ensure it has been resolved in a satisfactory manner. The
coordinator can then change the issue status to Closed.

The status for a clash or clashes is automatically set to invalid when one or both intersecting
objects are deleted in the design application, the model is published to InEight Model, and the
Update Issue function is executed.

An invalid status indicates that InEight Model can no longer detect the clash since it cannot
detect the source object or objects. Invalid clashes are treated as resolved.

Import issues

1. In the Issues panel, select the Import icon.

2. Select your BCF file, and then select Open. Your files are imported to an Imported Issues folder.
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Export issues

1. In the Issues panel, select one or more issues or select a group folder that contains issues.

2. Click the Export icon, and then select BCF 2.1 or BCF 3.0.

3. You can then name and save the file. The file is saved in a .bcfzip file format which can be
opened in other applications as shown in the image below:
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Update issues

1. Publish a new model revision.

2. Click the Update Issues icon.

The resolved clashes automatically change the clashes in the issues to a Resolved status. If all
clashes are resolved, the status for the Issue also shows as Resolved.

Delete a coordination issue

1. Select a coordination issue, and then click the Delete icon.

5.3 COORDINATION ISSUE REPORTING

Coordination Issue Reporting can be achieved by accessing Issues through the Excel plugin.
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Access Issues via Excel Plugin for Reporting

1. In Excel, select InEight in the menu ribbon.

2. Click the Login icon to log into your project. The Login to InEight dialog box opens.

3. Enter your password.

l The Select Project dialog box opens.
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4. Select your project, then click OK.

l User, Acct, and Project are shown.

5. Select the Table icon.
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6. Hover over Tracked Issues > Tracked Issue, and then click Query All.

All the Coordination issues are shown. This is a direct view into the database
tables
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Lesson 5 Review

1. Coordination issues are created from ______________ .

a. Model streams

b. Tags

c. Master presets

d. Clashes

2. Issue statuses always start as ______________ .

a. In progress

b. Open

c. Closed

d. Flagged

3. After resolving a coordination issue, the reviewer should physically review the site
to ensure the issue (and any potential related issues) is resolved.

a. True

b. False

Lesson 5 Summary

As a result of this lesson, you can:

l Create clash results
l Create and manage coordination issues
l Find nearby clashes and add clashes to an existing issue
l Create and manage coordination results
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LESSON 6 — ARCHIVE

Lesson Duration: 40 minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Import and manage project documents
l Link documents to objects and tags
l Link specific pages
l View documents within InEight Model

Topics in this Lesson



6.1 ARCHIVE OVERVIEW

The Archive is a repository for documents. Archive supports files of any size and type, provides fine-
grained permission controls, and retains a complete revision history. The Archive is accessible within
InEight Model, Mobile and Web applications.

Archive includes Archive Library for storing and managing files, and the Archive Viewer for viewing
supported files types.
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6.1.1 Archive Library

View, manage, and organize all project documents within the Archive Library. Create labels and link
documents to model object tags for enhanced usability.

To launch the Archive Library panel, select Archive > Library.

The Archive Library panel has two tabs: the Library tab and the Selection tab.

6.1.1.1 Library Tab

The Library Tab contains all the documents imported into the project. It provides the means to
organize documents within a folder structure and to link documents to model object tags.

Documents associated to tags will maintain its association through model updates,
assuming no manipulation to tags.
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6.2 MANAGE DOCUMENTS

Documents can be grouped in a folder structure, have permissions set at the folder level, have labels
assigned, and access document information.

6.2 Step by Step 1 — Import Documents

Documents in the Archive Library are either cached locally or only indexed from the online database.
Any document uploaded is automatically cached locally on the computer that uploaded it and is
represented by a green dot.

1. Select the Import icon.

2. Then select either File or Directory from the drop-down menu.
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• Windows Explorer opens

Drag and drop files and/or file folders into the Archive Library panel.

3. Browse to the File or Directory location.

4. If File was selected, select one or multiple documents to be imported, then click Open.

If Directory was selected, select on the directory folder to be imported, then click Open.
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• The Confirm Directory Import dialog box opens

5. Click OK.

6.2 Step by Step 2 — Download Documents

Any document within the Library represented with a red dot is only indexed from the online database
and needs to be downloaded to access it.

1. Within the Archive Library panel, select one or multiple documents.

2. Then select the Download icon.
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l Or right click and select Download Selected

l The Download dialog box opens

3. Click Download Selected.

l Download Entire Library: downloads and caches the entire library. Warning: this
can take a long time and use a lot of disk space with large libraries
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l Download Selected to External App: downloads the file directory to the local
computer without caching it locally to VEO_Cache

l Save to…: saves selected to a specific location

6.2 Step by Step 3 — Organize Documents

Organize and group documents by creating folders. Drag and drop folders and documents to rearrange
them as desired. Right click on the document or folder to rename it.

1. Within the Archive Library panel, click the Folder icon.

2. Name the folder.

6.2 Step by Step 4 — Delete Documents or Folders

1. Select one or multiple document(s) or folder(s), then click the Delete icon.

2. Answer the validation response(s).
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Deleting a folder will delete all documents within the folder. The deleted
document/folder is not deleted from the local cache.

There are additional options for removing documents/folders within the Right Click menu under
Delete:

l Delete > From Archive Library: removes document/folder from library (same as
Delete icon)

l Delete > Selected from Cache: removes only the local cache copy of a document
l Delete > Historical Versions from Cache: removes previous versions of
document/folder from local cache

l Delete > Upload Data from Cache: removes all locally uploaded document/folders
from local cache Warning: this can take a long time and InEight Model will be
unresponsive while it is in progress
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6.2 Step by Step 5 — Accessing Document Information

Additional document information is maintained within the document information window within the
Archive Library panel.

1. Select a document.

2. With the mouse on top of the slider bar, click and slide open.
l Or right click on a document and select Show Document Information

l The Document Information window opens
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l History: displays the historical information of the document
l Labels: displays the list of available labels and which labels are associated to the
document

l Objects: displays objects linked to the document
l Tags: display tags linked to the document

Right click on a document and select Copy Selected File Information to Clipboard
to paste document information to an external application (i.e. MS Excel, Word,
Email, etc.).

6.2 Step by Step 6 — Apply Permissions to Folders

Only Admin users can apply specific folder permissions. By default, folder permissions are
inherited by project level permissions.
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Permissions can be set at the folder level. Nested folders inherit parent folder permissions. By default,
folder permissions inherit project permission for users.

1. Select a folder, then right click and select Edit Folder Permissions.
l The Set Archive permissions dialog box will open

There are three permission levels:

l None Granted: folder is hidden
l Can Read: read-only permissions
l Can Read and Write: has read, write, and edit permissions

2. Select a Read permission.
l Can Read permissions are auto assigned to all groups within the system and all
users assigned to the project
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3. Make any changes as desired, then click OK.

4. Select a Hide permission.
l None Granted permissions are auto assigned to all groups within the system and all
users assigned to the project

5. Make any changes as desired, then click OK.

6. Select View / Edit Current Permissions.
l Displays all Current Permissions for the folder with applying any changes as it opens
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6.2 Step by Step 7 — Search Documents

Search filters the library list to the criteria in the search bar and only searches on the File Name of the
Document and/or Folder.

When using Filters in conjunction with Search, only visible content is searched.

1. Type in criteria within the Search bar.

6.3 CREATE AND MANAGE LABELS

Labels can be utilized to quickly group and filter files. Multiple labels can be assigned to files.

6.3 Step by Step 1 — Create and Apply a Label to a Document

1. Select one or more documents.

2. Click the Label icon.
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l Or, right click and select Label Selected

l The Add or remove labels dialog box will open

3. Type in a name, then click Add.
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l The Label dialog box will stay open and show a checked box with a new label

Labels only display in the Add or Remove Label dialog box if they have been applied
to document. Once a label has been removed from all documents, it will no longer
appear in the Add or Remove Label dialog box.

1. Select anywhere outside of the Label dialog box to close it and apply the checked label.
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6.3 Step by Step 2 — Apply an Existing Label to a Document

1. Select one or multiple documents.
l And/Or select one or more folders

2. Click the Label icon.
l Or right click and select Label Selected
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3. Select the desired labels to apply to the selected documents.

4. Select anywhere outside of the Label dialog box to close it and apply the checked label(s).
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6.3 Step by Step 3 — Apply or Remove Labels within the Document Info area

1. Select one or multiple documents.

2. With the mouse on top of the slider bar, click and slide the advanced panel open.
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l Manage labels within the Labels tab
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6.3 Step by Step 4 — Filter Documents by Labels

1. Select the Filter icon.

l The Filter Criteria dialog box opens

The Filter Criteria is configured as an ALL criteria. The documents are filtered as ALL
criteria is met within the Filter Criteria dialog box.
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l Has Label: Filter documents according to checked labels
l Status: Filter documents according to their status (All, Unlinked Docs, Not
Downloaded, or Downloaded)

l Upload Date: Filter documents according Uploaded Date criteria
l UploadBy: Filter documents according to who uploaded the documents
l FileType: Filter documents by file type
l Clear: Clear

6.4 LINK AND MANAGE DOCS TO TAGS

Documents can be linked directly to model object tags. Linking documents provides a convenient way
to quickly access applicable documents by selecting model content within the 3D Viewer window.
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6.4 Step by Step 1 — Link Documents to Tags

1. Within the Tags and Objects panel, select a Tag Value (i.e. Pile).

2. Within the Archive Library panel, select one or multiple documents.

3. Click the Assign icon.
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Drag and drop a document onto a Tag Value within the Tags and Objects panel.

6.4 Step by Step 2 — Associate a Specific Page within a PDF document to a Tag

After a PDF document has been linked to one or more model object tags, a specific page within the
PDF can be associated to the link, so that, when the document is opened via the link, it will open to the
associated page.

1. Select a PDF document that has been associated to a tag.

2. Open the Document Information window.
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3. Double click on the page number, then type in the desired page number.
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6.4 Step by Step 3 — View and/or Remove an Object Tag Link via the Document
Information Window

1. Select a document.

2. Open the Document Information window.

3. Select the Tags tab.

4. Select the Tag Link to view the linked model object.

5. Right click and select Remove Tag Link to remove the link.

Page 384 of 490 InEight Inc.  |  Release 23.10

6.4 Link and Manage Docs to Tags Model User Guide



6.4 Step by Step 4 — View and/or Remove a Document Link via the Selection
Tab

The Selection tab within the Archive Library displays all documents linked to the Actively Selected
Model Objects.

1. Select one or multiple model objects or a tag.

2. Within the Archive Library, select the Selection tab.

3. View associated document content by double clicking on the document.
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4. To remove a link, select a document from the list, then click on the Unassign icon.
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Lesson 6 Review

1. You can view all project documents from the _____________ tab of the Archive
Library.

a. Objects

b. Tags

c. Selection

d. Library

2. You can only link a document to one object.

a. True

b. False

3. You can download documents from a model to keep on your desktop.

a. True

b. False

Lesson 6 Summary

As a result of this lesson, you can:

l Import and manage documents
l Link documents to objects and tags
l Link specific pages
l View documents within InEight Model
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LESSON 7 — SELECTION INFO

Lesson Duration: 10 minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Navigate the Selection Information panel

Topics in this Lesson



7.1 SELECTION INFO OVERVIEW

The Selection Information panel displays attribute data of actively-selected model objects. The
displayed attribute data will change accordingly to the actively-selected model objects. The tabs within
the Selection Information panel displays grouped attribute data. If there are no model objects
selected, then the Selection Information panel will be blank.

7.1.1 Selection Information Panel

To access the Selection Information panel, select Object from the menu bar at the top left of the
screen. Then, select Selection Information.
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7.1.2 General Tab

The General tab displays the Model Stream name of the selected objects, the Material Name – CAD
tag value for each model object selected, the total surface area, the total volume, and the total
number of objects currently selected.

7.1.3 Tags Tab

The Tags tab displays all metadata for the selected objects, the number of objects per metadata, and
the total number of objects currently selected.
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There are additional actions that can be taken within the Tags tab: Filter the Selection,
Select similar tags, and Tag Selected objects with a new tag.

l Select Tag - Right Click on a tag value, then click Select Tag to select all objects with the
same tag
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l Tag Selected - Click the Tag Selected icon to open the Create Tag dialog box

7.1.4 Style Tab

The Style tab displays all the styles associated with the selected object.
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The Style tab will not display information when multiple objects are selected.

7.1.5 Documents Tab

The Documents tab displays the documents associated to the selected objects.

Page 394 of 490 InEight Inc.  |  Release 23.10

7.1 Selection Info Overview Model User Guide



There are additional actions that can be taken within the Documents tab: Filter the
Selection, Open the Documents, or Reveal the documents in Archive Library.

Right Click on a document for additional actions.
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7.1.6 Object Properties Tab

The Object Properties tab displays only the metadata that was selected as Object Property during the
Model Stream Export/Import process.
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There are additional actions that can be taken within the Object Property tab: Filter the
Selection and toggle a Parameter as a favorite. The favorited Parameters will appear at
the top of the list.

7.1.7 Linked Data

The Linked Data tab can be associated to Record Tables created within InEight Compliance.
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7.1.7.1 Selection Filter

The Selection Filter can be launch by clicking on the Filter icon from any of the tabs. Then uncheck any
of the Enable check boxes to fine tune your selection.
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Lesson 7 Review

1. Which of the following is NOT a tab on the Selection Information panel?

a. Object Properties

b. Documents

c. Coordination

d. Linked Data

Lesson 7 Summary

As a result of this lesson, you can:

l Navigate the Selection Information panel
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LESSON 8 — SECTIONING

Lesson Duration: 40 minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Apply sectioning using the set box
l Apply sectioning by dragging and dropping a tag
l Apply sectioning by the offset
l Reset the sectioning box to model boundary
l Use sectioning with master presets

Topics in this Lesson



8.1 SECTIONING OVERVIEW

Sectioning lets you isolate a certain section or area of a project to easily visualize model content.
Adjust the Sectioning box in the 3D viewer by managing the Top, Bottom, Left, Right, Front, and/or
Back planes of the box.

When the mouse cursor moves through the Sectioning panel a yellow outline is shown
along with a corresponding yellow line in the 3D view indicating the current edge of the
section.

8.1.1 Sectioning Panel

To access the Sectioning panel, select View from the menu bar at the top of the screen. Then, select
Sectioning.
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This opens the Sectioning Panel.

Toggle OFF to ON to initiate a section box. Toggle HIDE to SHOW to see the section box in the 3D View.

l Set Box – Sets the entire section box to the selected objects boundary. Or if no objects are
selected, then it resets the section box to the model boundary.

l Offset / Offset All – Adjusts the section box according to the entered criteria.
l TOP / BOTTOM / LEFT / RIGHT / FRONT / BACK – Can be enabled and can be set
according to selected objects or no objects selected. If objects are selected, then the
section is set to the object boundary. If no objects are selected, then the section is set to
the model boundary.

l Rotation – Rotates the section box.

8.1.2 Sectioning Icon

Sectioning can also be switched ON or OFF with a left mouse click on the Section icon located at the
bottom left of the screen. Switch SHOW/HIDE, and launch the Sectioning Panel with a right click on
the icon.
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8.2 CREATE AND APPLY SECTIONING

Sectioning can be applied in different ways to yield desirable results.

8.2 Step by Step 1 — Apply Sectioning Using the Set Box

1. Switch Sectioning ON.

2. To see the sectioning box in the 3D viewer, toggle SHOW.

3. Select a model object or a tag.
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4. Click the Set Box icon.
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l The Sectioning box has been set to the model objects boundaries

8.2 Step by Step 2 — Apply Sectioning by Dragging and Dropping a Tag

1. Switch Sectioning ON.

2. From the Tags and Objects Panel, select a tag.

3. Drag and drop the tag onto a section part in the Sectioning Panel.
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8.2 Step by Step 3 — Apply Sectioning by the Offset

1. Switch Sectioning ON.

2. With the mouse over an Offset field, scroll the mouse wheel to set a numeric offset

3. Or type in the preferred numeric offset.

8.2 Step by Step 4 — Move Sectioning Panes with Grips

1. Switch Sectioning ON.

2. Switch Section Box ON.

3. Hold the CTRL key and hover over the sectioning panes to see them highlight.

4. Hold CTRL + LMC (left mouse) to move a sectioning pane.
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8.2 Step by Step 5 — Reset the Sectioning Box to Model Boundary

1. Switch Sectioning ON.

2. Ensure no model object is selected.

3. Click the Set Box icon.
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Any of the Section Parts can be reset individually by ensuring that no model objects
are selected, then select the specific Section part Set icon (that is, Set Top).

8.2 Step by Step 6 — Use Sectioning with Master Presets

1. Switch Sectioning ON.

2. Adjust the Sectioning as desired.

3. In the Master Preset Editor, click Sectioning.
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Lesson 8 Review

1. You can quickly access sectioning from the Sectioning icon on the menu in the
bottom, left.

a. True

b. False

2. You can apply sectioning to master presets.

a. True

b. False

Lesson 8 Summary

As a result of this lesson, you can:

l Apply sectioning using the set box
l Apply sectioning by dragging and dropping a tag
l Apply sectioning by the offset
l Reset the sectioning box to model boundary
l Use sectioning with master presets
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LESSON 9 — MEASUREMENTS

Lesson Duration: 40 minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Navigate the Measurement panel and enter Measuring Mode
l Take and delete measurements
l Organize and clear measurements

Topics in this Lesson



9.1 MEASUREMENTS OVERVIEW

The Measurements module lets you enter values to view your model in 3D, and then save the values in
a folder for reference and use later. You must select a measure Mode to take measurements.

9.1.1 Measurement window

To access the Measurements window, select View >Measurement. The Measurement window opens.

The Measurement window has six sections as shown below:
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1 Measurement settings – Measurement settings – Lets you manage the mode, units,
format, and precision of a measurement.

l Mode - Select between different modes to take your measurements:
o Point to Point - Basic Point A to Point B measurement.
o Continuous – Lets you continuously measure along a series of chosen points.
Double-click on the last point to end the continuous measurement.

o Area – Select a series of points that define an enclosed area. Close the area
measurement by clicking on Point A. Points picked must be on the same
plane.

o Angle – Lets you pick three points to find an angle.
o Spot ID – Select a point to show the X, Y, Z coordinates of the point. Spot IDs
can be copied to clipboard.

o Units - Select a unit to be shown when taking a measurement. Units are
constrained according to the type of mode that is selected and will be denoted
in italics and cannot be unselected.

o Format - Select a format to show when taking a measurement. Formats are
constrained according to the type of mode that is selected and will be denoted
in italics and cannot be unselected.

o Precision - Select the best precision for your measurement.

2 Measurement options – You can adjust how the measurement tools interact with objects
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and how measurements are calculated.
l Ignore Translucent – You can select or unselect the Ignore Translucent objects
during measurement mode. When selected, translucent objects in the view window
are ignored. This lets you indicate whether translucent objects, such as room,
operation, or maintenance volumes are included in the model project.
Measurements do not consider translucent objects.

l Respect Site Rotation - Measurement calculations are defined according to the
Site Rotation Values defined on Model stream import.

3 Object Snaps – Lets you select one or multiple object snaps to define selection type of
taking a measurement. Face and Object are exclusive snaps and cannot be active at the
same time.

l Vertex – Snap to any corner or endpoint.
l Midpoint – Snap to the middle of an edge.
l Center – Snap to the center of a face.
l Face – Snap to any face. The measurement is calculated according to the closest
point between the face selected and the other objects involved in the
measurement.

l Object – Snap to any object. The measurement is calculated according to the
closest point between the object selected and the other objects involved in the
measurement.

4 Selection Distance – The total value of the measurement is shown, along with the X, Y, Z
deltas when applicable.

5 Measurements – There are two root level groups in the Measurement tree. The Temp
group captures all measurements as they are created. The other group shows the Project
name, so you can create additional groups and organize project measurements.

6 Selection Details – All the details related to the selected measurement are shown. You
can copy and paste in the free-form text section.

9.2 APPLY AND MANAGE MEASUREMENTS

Enter the Measurement Mode to start measuring the model.
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9.2 Step by Step 1 — Enter Measurement Mode

1. Select the Ruler icon in the notification tray to toggle the Measure Mode on and off.

l Alternatively, press the M key on the keyboard to toggle the Measure Mode

While in Measure Mode the cursor will become a cross hair and the Ruler icon will
appear white.

Right-click on the Ruler icon to Start/Stop Measurement or to open the
Measurement panel.

9.2 Step by Step 2 — Take a Measurement

1. Enter Measure Mode.

2. Select the first point (it will be labeled “A”).

3. Select the second point (it will be labeled “B”).

This lettering series will continue in order for measurement types consisting of
more than two points.
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l The first object in the measurement will be highlighted blue
l The second object in the measurement will be highlighted in red
l The total distance between the selected points will be displayed in orange along the
orange measurement line, which represents the closest distance between those
points

l Additionally, the X, Y, Z details of each axis will be drawn as dotted lines with their
respective values displayed along the path of the dotted line. The X, Y, Z axes will be
colored red, green, and blue respectively

While Measure Mode is active, hold control to restore navigation to move without
having to exit Measure Mode.
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l The first object in the measurement will be highlighted blue
l The second object in the measurement will be highlighted in red
l The total distance between the selected points will be displayed in orange along the
orange measurement line, which represents the closest distance between those
points

l Additionally, the X, Y, Z details of each axis will be drawn as dotted lines with their
respective values displayed along the path of the dotted line. The X, Y, Z axes will be
colored red, green, and blue respectively

While Measure Mode is active, hold control to restore navigation to move without
having to exit Measure Mode.
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9.2 Step by Step 3 — Delete a Measurement

1. Select a Measurement, then click the Delete icon.

Another option is to right-click on the measurement, then select Delete.

9.2 Step by Step 4 — Clear Measurements

Clear allows the user to clear any measurements selected, which also clears the 3D view of displaying
measurements.
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1. As one or more measurements selected, click the Clear icon.

9.2 Step by Step 5 — Organize Measurements

Create groups under the project named folder to move measurements into.

1. Select your project named folder.

2. Select the Group icon.
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Another option is to right-click on the folder, then select New Group.

l The New Folder dialog box will open

3. Enter a folder name, then click OK.

4. Drag and drop measurements into a folder.
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5. Right click on the measurement to rename it and better identify the measurement.
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Lesson 9 Review

1. Which of the following is NOT an option on the Measurements panel? 

a. Master presets

b. Object Snaps

c. Selection Distance

d. Selection Details

2. You cannot save measurements in InEight Model.

a. True

b. False

3. To begin working with measurements, you must first enter Measurement Mode.

a. True

b. False

Lesson 9 Summary

As a result of this lesson, you can:

l Navigate the Measurement panel and enter Measuring Mode
l Take and delete measurements
l Organize and clear measurements

LESSON 9 — MODEL EXPORTS

Lesson Duration: 40 minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Navigate the Measurement panel and enter Measuring Mode
l Take and delete measurements
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l Organize and clear measurements

Topics in this Lesson

9.1 IFC EXPORT

With IFC Export, you can select model objects and then export selected graphics and related TAG data
into an IFC file format. This provides the ability to export collaborative updates to project teams
members.

IFC 2x3 is the supported file type in Model. IFC files are an open international standard for Building
Information Modeling (BIM) data that are exchanged and shared among software applications used by
the various participants in the construction or facility management industry sector.

9.1 Step by Step 1 — IFC Export

1. To access IFC Export, select File from the menu bar at the top of the screen.

2. Select Export Selected to IFC…. The Windows Explorer opens.

3. Browse to the desired location to store the .ifc file.
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4. Name the .ifc file with a relevant name , and then click Save.

9.2 OBJ EXPORT

With the OBJ Export, you can select model objects, and then export selected graphics and related TAG
data into an OBJ file format.
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9.2 Step by Step 1 — OBJ Export

1. To access OBJ Export, select File from the menu bar at the top of the screen.

2. Select Export Selected to OBJ... Windows Explorer opens.

3. Browse to the desired location to store the .obj file.

4. Name the .obj file with a relevant name, and then click Save.
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LESSON 9 — MODEL-BASED TAKEOFF

Lesson Duration: 40 minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Navigate the Measurement panel and enter Measuring Mode
l Take and delete measurements
l Organize and clear measurements

Topics in this Lesson
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9.1 MODEL-BASED TAKEOFF OVERVIEW

There are two methods of utilizing quantities from Model. One way is to use the Quantity function
with the DTOs and access the quantities through the Excel Plugin. Another way is through the Model
and Estimate integration.

9.1.1 Model and Estimate integration

Model can be utilized to sum object quantities and sync quantities to Estimate.

Estimate has a section of integration functions to communicate with Model. These functionalities are
found in the main ribbon underMore Actions and then in theModel Connector area.

l Select in Model- This toggle lets you select a cost item. The linked Model objects are then
selected within Model.

l Frame Selected- This toggle lets you select a cost item. The linked Model objects are then
framed within the Model viewer.

l Sync Model Quantities- After the quantities have been summed via a DTO execution, then they
can be synced from Model into Estimate.

l Send Selected CBS to Model- Whether the parent of cost items or cost items are selected, the
whole parent to children CBS structure will is pushed to Model.

There are 4 hardcoded fields that can also be used to pass data information from Estimate to Model,
User Defined fields 12 through 15. Any information added to these fields will populate DTO Selector
information when the cost item is pushed from Estimate to Model.

InEight Inc.  |  Release 23.10 Page 431 of 490

Model User Guide 9.1 Model-based Takeoff Overview



l User Defined 12 is used for the Tag / OP Name within the first rule.

l User Defined 13 is used for the Value of the Tag / OP Name within the first rule.

l User Defined 14 is used for the second Tag / OP Name within the second rule. It is also used for
modifier with combination of the first and second rule.

l User Defined 15 is used for the Value of the Tag / OP Name within the second rule.

9.1.2 Requirements for Model and Estimate integration

l Estimate version 2023.0 or later must be installed.

l The Estimate add-in for Model Client Plugins must be installed.

l InEight Model must be installed.

l One instance of InEight Model and one instance of InEight Estimate must be open on the same
computer.

9.2 MODEL TO ESTIMATE INTEGRATION

The following step-by-step walks you through the basic Model and Estimate integration.

9.2 Step by Step 1 — Estimate to Model integration

1. Create a new estimate or start with a template estimate.

2. Launch Model and select Load a Project.

3. Open the DTO panel.

4. In Estimate, select a cost item or parent of a cost item.

5. In the top ribbon, selectMore Actions.

6. In the Model Connector section, select the Send Select CBS to Model button.
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7. Click OK to close the Success dialog box when it shows.

The selected CBS structure is now sent over to Model’s DTO panel.

9.2.1 Model integration configuration

The CBS structure of the selected cost item or parent cost item is now represented in the DTO panel.
The CBS hierarchy is translated into DTO Groups and DTOs. All levels of the hierarchal tree create DTO
Groups, with the last level of the tree creating a DTO.

The DTO utilizes the Selector area to create criteria to select model objects. The Operations area
creates the summation of the quantities to share with Estimate.
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The following step-by-step walks you through how to run Model DTOs.

9.2 Step by Step 2 — Run Model DTOs

1. In Model, select a DTO.

The Selector area has no predefined rules.

a. The Operations area has been set to Action Type: Quantity

b. Quantity Type, Code, Units, and Description fields are populated from Estimate.
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2. Create one or more rules to find Model objects that should be included for the DTO 2.1.1 –
Caissons – Installed for the parking garage.
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3. Click Test to validate and review all the information for model objects in the Selection
Information Panel.

4. Validate that Quantity type is set to the desired summation of the quantities.
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5. Repeat steps 1 thru 4 for the other DTO (Cost Items).

6. Run the individual DTOs or select higher in the hierarchy in which all the DTOs are under.

7. Right-click on a DTO Group, and then select Run Selected DTO.
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9.2.2 Sync Model Quantities in Estimate

The following step-by-step walks you through how to sync Model quantities in Estimate.

9.2 Step by Step 3 — Sync Model quantities

1. In Estimate, select theMore Actions tab in the top ribbon.

2. In theModel Connector section, select Sync Model Quantities.

a. The Sync Model Quantities dialog box opens.

b. The Model QTY column shows the quantities in Model.
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c. The Current QTY column shows the Forecast (T/O) Quantity in Estimate.

3. Multi-select all cost items, and then select the check boxes.

4. Click Accept.

The quantities derived from the model are now in Estimate.
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9.2.3 Select and frame Model objects

The following step-by-step walks you through how to select and frame Model objects.

9.2 Step by Step 4 — Select and frame Model objects

1. In Estimate, select theMore Actions tab in the top ribbon.

2. In the Model Connector section, select the check boxes for Select in Model and Frame Selected.
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3. Select a cost item in Estimate and see the model in Model reflect which model objects were used
to create the quantities.

9.2.4 User Defined Fields

User Defined Fields (UDF) in Estimate align with Tag Category and Tag value in Model.

l UDF 12 = Tag Category

l UDF 13 = Tag Value from UDF 12 Tag Category
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l UDF 14 = Tag Category

l UDF 15 = Tag Value from UDF 14 Tag Category

If UDF 12 and UDF 13 are populated and UDF 14 and UDF 15 are not populated, then only one rule is
created in the DTO Selector area. If all four UDFs are populated, then two rules are created.

The following step-by-step walks you through rule setup for UDF fields 12 and 13.

The Tag / OP Namemust exist within the model or it will be set to a random Tag / OP.
The Operator is set to = by default. The Valuemust exist within the model or it will be set
to a random value.

9.2 Step by Step 5 — Rule setup UDF fields 12 and 13

1. In Estimate for cost item 2.1.1, type z_Foundations into UDF field 12.

2. For cost item 2.1.1, type G1-Foundation Pier into UDF field 13.

3. In the ribbon, select theMore Actions tab.

4. Select the Send Selected CBS to Model button.

5. When the Success dialog box opens, click OK.

The Model DTO Selector then automatically creates a rule from the info provided in the UDF
fields.
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The following step-by-step walks you through rule setup for UDF fields 12 through 15.

The Tag / OP Namemust exist within the model or it will be set to a random Tag / OP.
The Operator is set to = by default. The Valuemust exist within the model or it will be set
to a random value.

9.2 Step by Step 6 — Rule setup UDF fields 12 through 15

1. In Estimate for cost item 2.1.1, type z_Foundations into UDF field 12.

2. For cost item 2.1.1, type G1-Foundation Pier into UDF field 13.

3. For cost item 2.1.1, typeModel into UDF field 14.

4. For cost item 2.1.1, type STRUCT_Parking into UDF field 15.
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5. In the ribbon, select theMore Actions tab.

6. Select the Send Selected CBS to Model button.

7. When the Success dialog box appears, click OK.

The Model DTO Selector then automatically creates a rule from the info provided in the UDF
fields.
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LESSON 10 — ELEMENTS

Lesson Duration: 40 minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Navigate the Elements panels and dialogs
l Know how to create an Element
l Create Elements from objects
l Unlink objects from an Element
l Delete an Element

Topics in this Lesson



10.1 ELEMENTS OVERVIEW

Elements formalize relationships between components, equipment, systems, subsystems, etc.
Maintaining the thread of data from Design to Construction to Quality to Closeout; customizable based
on project requirements and participating in an Advanced Work Packaging process.

The new Elements panel within InEight model provides the capability to create Material Components
(individual or combined model objects). The Material Components created in Model are linked to the
AWP process (Model <-> Plan and Model <-> Schedule) and to the Completions applications.

Within Completions, Assets have been transitioned into Elements, which provides a direct link from
Completions to Model. In a general since, Elements created in Completions are now visible within
Model and Elements created in Model are visible in Completions

Elements are more flexible than Assets in that they can have a hierarchical relationship and display
different data based on Element type or classification (system, subsystem, building intersection,
engineered equipment, etc.) With this transition, users can access Elements data from Completions
HQ, Mobile, and Model applications.

10.1.1 Elements Panel

To access the Elements Panel, select View from the menu bar at the top of the screen. Then, select
Elements.
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This will open the Elements Panel.
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Elements created within the Model application or the Completions application will be displayed.

l Element Type: A dropdown selection to filter displayed Elements

l Add...: provides the ability to:

l Create a single Component

l Create multiple Components from a selection

l Settings...: provides the ability to:

l Toggle on/off the Auto-select model elements feature

l Toggle on/off the Show linked model elements feature

l Toggle on/off the Drop from Object Tree creates single Material Component feature

l Toggle on/off the Compact Mode feature

10.2 CREATE AND MANAGE ELEMENTS

You can create elements and link tags or objects to those elements by clicking the Add icon or moving
tags and objects to the Elements panel.
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10.2 Step by Step 1 — Create an element

1. Click the Addicon.

2. Select Add Component.

3. Fill in the component fields.

InEight Inc.  |  Release 23.10 Page 449 of 490

Model User Guide 10.2 Create and Manage Elements



Field name Value

1 Element Type Select Material Component.

2 Element Name Type in a name that represents the material component to be
created.

3 Description Enter a description for the material component.

4 Linked model
item

This is used only when Add Component from Selection option
is selected.

5 use Field
mapping

N/A

You can see the new completed component in the Create Element dialog box.
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4. Click OK, and then the new Material Component shows in the Elements panel.

The Element ID, Element Type, and Description cannot be changed. You must
delete and recreate a new element.

5. You can add a model object to the element two different ways:

l Drag one or more tags into the element from the Tags tab.
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The tags show below the element.

l Drag objects into the element by selecting one or more model objects from the
Objects tab.
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The objects show below the element.

The object values or tag values are linked to the element. When selecting
values in the Elements panel, those values are also selected in the Tags and
Objects tree.
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10.2 Step by Step 2 — Create elements from a selection of objects

1. Select one or more model objects.

2. Click the Add icon.

3. Click Add Components from Selection.

The Create Element dialog box is populated.
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Field name Value

1 Element
Type

Select Material Component.

2 Element
Name

Do not delete <ObjName>. This ensures that all the added objects are
unique. You can add any text after the <ObjName> if needed.

3 Description Optionally type a description for the material component.

4 Linked
model items

This is used only when Add Component from Selection option is selected.

5 use Field
Mapping

N/A
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4. Click OK, and then the new Elements show in the Elements panel.

Each model object will have an element created with the individual model object
linked to that element.
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10.2 Step by Step 3 — Create elements from the tags

1. To create elements from tags, in the Tags tab, drag one or more tags into the Elements panel.

The tags show below the element.

The element name will be derived from the tag, and the tag value is linked to the
respective element.

10.2 Step by Step 4 — Edit an element

1. In the Elements panel, right-click an element, and then select Edit Element.

The Edit Element panel opens and shows the associated element data.
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2. Edit the element as needed.

3. Click OK to save your changes. Fields that cannot be edited show in a solid color.

10.2 Step by Step 5 — Unlink objects from an element

1. Select an object or objects in one or more elements.

2. Right-click on the selected items, and then select Unlink item.
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10.2 Step by Step 6 — Delete an element

1. Select one or more elements.

2. Right-click on the selected items, and then select Add/Remove Element > Delete Selected
Elements.
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Lesson 10 Review

1. The Material created are linked to the AWP process.

a. True

b. False

2. Elements have more ______________ than Assets in that they have a __________
___________ relationship and display different data based on Element type.

a. information, variety

b. flexible, hierarchical

c. relationship, classification

3. Elements formalize relationships between these: (select all that apply)

a. tags

b. components

c. equipment

d. assets

e. data

f. systems

g. subsystems

Lesson 10 Summary

As a result of this lesson, you can:

l Navigate the Elements panels and dialogs

l Know how to create an Element

l Create Elements from objects

l Unlink objects from an Element

l Delete an Element
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LESSON 10 — ADVANCED WORK
PACKAGING & WORKFACE PLANNING

Lesson Duration: 40 minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Work Packaging Overview
l Creating & Managing CWAs, CWPs, & IWPs

Topics in this Lesson

10.1 WORK PACKAGING OVERVIEW

InEight Model allows visual work packaging to support an Advanced Work Packaging (AWP), Work Face
Planning (WFP), or any other work scoping process.

Work Packaging breaks down projects into small, manageable scopes of work so that operation can be
assigned to responsible supervision, executed, and tracked effectively. Within InEight, our approach is
to break the work of your project into Construction Work Areas (CWAs), Construction Work Packages
(CWPs), and Installation Work Packages (IWPs).

AWP activities span the entire project. Front-end planning and detailed engineering activities support
enhanced execution at the work front. Project set-up and planning sessions establish the basis for
coordinated construction, procurement, and engineering work packages (CWPs, PWPs, and EWPs).

AWP drives the WFP concepts to Engineering and Procurement. Drawings are issued to construction
and vendors as complete Engineering Work Packages (EWP) and Procurement Work Packages (PWP)
instead of individual drawing releases. The objective is to ensure all parties follow the project Path of
Construction.
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10.1.1 AWP Panel

To access the AWP Panel, select View from the menu bar at the top of the screen. Then, go to the
Optional Modules and then select AWP.
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This opens the AWP Panel.

• AWP Panel will display Work Packaging structure items (CWA, CWP, IWP) created in InEight Model,
InEight Plan, or InEight Schedule applications

• Name: Work Package unique name or code

• Description: Brief work package description

• Start: Schedule start date

• Finish: Schedule finish date

• % Complete: Percent complete (earned work-hour basis)

• Platform: Identifies which platform (Model, Plan, Schedule) created work package structure item

• Add: provides the ability to:

l Add CWA

l Add CWP
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l Add IWP

l Remove Item

• Settings: provides the ability to:

l Toggle on/off the Auto-select material components feature

l Visually select model objects that are assigned to work package structure

l Toggle on/off the Show % complete feature

l Activates progress visualization mode

l Toggle on/off the Compact Mode feature

l Reduces AWP panel down to only show CWA/CWP/IWP names

l Toggle on/off the Edit RUID feature

l Opens the AWP panel column customization widget

10.2 CREATING & MANAGING CWA, CWP & IWP

The InEight platform allows users to generate AWP structure components (Construction Work Areas
(CWAs), Construction Work Packages (CWPs), and Installation Work Packages (IWPs)) within Schedule,
Plan, and Model. InEight’s cloud-based platform allows real-time synchronization between the
solutions.

Adding to the existing AWP structure or creating a new structure to reflect the current project status is
available in the Model.
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10.2 Step by Step 1 — Create a Construction Work Area (CWA)

1. Select Add.

2. Click Add CWA.
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3. Fill out the CWA ID (project unique code or identifier).

4. Click OK, then the new CWA will display within the AWP panel.
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The platform name highlights which of the InEight solutions generated the CWA.
Any CWA created in InEight Plan or Schedule will be available within Model.

10.2 Step by Step 2 — Create a Construction Work Package (CWP)

1. Select an existing CWP item, then Select Add.

2. Click Add AWP.
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3. Fill out the CWP ID (project unique code or identifier).

4. Click OK, then the new CWP will display within the AWP panel.
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The platform name highlights which of the InEight solutions generated the CWP.
Any CWP created in InEight Plan or Schedule will be available within Model. With
the InEight platform, additional metadata associated with the CWP will be visible
within the InEight Model. Connecting AWP structure with InEight Schedule allows
for schedule metadata to be visible within the InEight Model. Connecting AWP with
InEight Plan & Progress allows for work-hours, progress percent complete, and
other metadata to be visible within the InEight Model.
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10.2 Step by Step 3 — Create a Installatoin Work Package (IWP)

1. Select an existing CWP item, then Select Add.

2. Click Add IWP.

3. Fill out the IWP ID (project unique code or identifier).
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4. Click OK, then the new IWP will display within the AWP panel.
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The platform name highlights which of the InEight solutions generated the IWP.
Any IWP created in InEight Plan or Schedule will be available within Model. With
the InEight platform, additional metadata associated with the CWP will be visible
within the InEight Model. Connecting AWP structure with InEight Schedule allows
for schedule metadata to be visible within the InEight Model. Connecting AWP with
InEight Plan & Progress allows for work-hours, progress percent complete, and
other metadata to be visible within the InEight Model.

10.2 Step by Step 4 — Deleting AWP Structure

1. Select one or multiple AWP structure items.

Removing AWP structure items (CWA / CWP / IWP) must happen at the lowest
level of the structure first. If an IWP has elements associated with it, these
elements must be unlinked before deleting. The same logic applies to CWPs and
CWAs.

2. Right mouse click on the AWP structure items, then select Remove IWP (or Remove CWP, or
Remove CWA).
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10.2 Step by Step 5 — Filter AWP Structure

Filter the AWP structure per predefined criteria

Select one or multiple AWP structure items.

1. Select the Filter tab, then set the criteria as desired.

Additional filters can be added as desired.

10.3 USER MANAGEMENT

10.4 USER MANAGEMENT

When InEight Model is integrated with InEight Platform, users are managed in Platform. For more
information, see User management in Suite administration.
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10.1 INTRODUCTION

Admin Tools are not integrated with InEight Platform, therefore it is a central portal for administrators
to configure the settings of Legacy Completions, Model projects, and user accounts.

10.1.1 Browser compatibility

Admin Tools is compatible with the following browsers:

l Chrome

l Firefox

l Safari

l Edge

10.2 LOGIN

Single sign-on (SSO) reduces the need to maintain separate credentials to access Admin Tools. You can
use existing credentials to open Admin Tools.

Conversion to single sign-on (SSO) applies across all InEight Model and Completions
applications including Admin Tools and the Excel Plugin.

You must go through your InEight services representative to convert to SSO.

One SSO user per email address is permitted in an account.

Page 474 of 490 InEight Inc.  |  Release 23.10

10.1 Introduction Model User Guide



The login screen lets you use a single set of credentials and authenticate with SSO provider (Google or
Microsoft) to sign into any projects that you have access to. SSO increases administrative efficiency by
mitigating new user creation. Existing users can continue to sign in using their existing user name and
password.

SSO authentication reduces the need to maintain separate credentials, and also minimizes the need to
maintain a standalone set of credentials.

To enable SSO functionality for your organization, contact your account administrator.

User organizations can integrate with the Excel Plugin authentication service with their own existing
authentication servers, which eliminates the need for standalone Excel Plugin user credentials.

Single sign-on recognizes which accounts users have access to, and presents a helpful account drop-
down list. Authenticated users are then presented with a list of projects in the selected account that
are controlled and assigned by the administrator.
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10.2.1 Log-in Options

10.2.1.1 Username and Password Credentials

Reset password

If you forget your password, click Forgot password. Enter your user name, account, and email address,
and then click Submit. If your request is successful, an email is sent to you with instructions to
complete your password reset. Return to the login page to enter your new password.

The Submit button is disabled until you enter a valid email address..
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10.2.1.2 SSO by Microsoft
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10.2.1.3 SSO by Google

10.2.2 Switch account

The Switch account button, located on the lower left panel, lets SSO users change between accounts to
access different project lists.
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10.3 SLIDE-OUT PANEL

The slide-out panel gives you quick links to pages both inside and outside of Admin Tools. You can also
use the slide-out panel to log out of Admin Tools.
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To open the slide-out panel, click theMain menu icon.

The slide-out panel contains the following links:

l User Account Management – See User Account Management for information about this page.

l Online Training Portal – Takes you to the Knowledge Library.

l Completions Web – Opens the Completions web interface in your browser.

l Feature Request – Submit a request for a new feature.

l Support – Opens an email to InEight support.

l Switch Account - Lets SSO users change between accounts to access different project lists.

10.4 PROJECTS

The Projects page shows all available projects. When you log to Admin Tools, the Projects page is the
first page that opens. You can also click the Home icon to open the Projects page.

There are several methods to open the Configurations page opens for a specific project:
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l Double-click the project name.

l Select a project, and then click Configure.

l Right-click a project, and then select Configure from the drop-down menu.
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10.5 USER ACCESS OVERVIEW

There are three types of users:

User type Description

Admin Allows you to have complete access and control of all
functionality in the environment.

Standard Allows you to have limited access and functionality in a
project. You will not be able to:

l Create users.
l Create projects.
l Delete an object in Viewer.

Read-Only Allows you to have read-only rights to a project. You can
access and utilize all functionality in a project. You will not
be able to:

l Save any changes to a project.
l Create users.
l Create a project.
l Publish models.

The default user type is Standard. You can assign a user type when creating a new user.
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Users can have Read or Write access to a project.

If a Read Only type user is applied to a project with Write access, they will still only have
read only rights to the project.

If a Standard or Admin type user is applied to a project with Read Only access, they will
only have read only access.

10.6 USER ACCOUNT MANAGEMENT

User Account Management settings let you manage users, user groups, and access to projects. You can
navigate to User Account Management through the quick link in the slide-out panel.

You must be an account administrator to manage user accounts.

The User Account Management has two tabs:
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l Users & Groups – Manage users and user groups.

l Project Permissions - Assign users and user groups to projects.

10.6.1 Users & groups tab

The Users & Groups tab has two panels. The Users panel lets you manage users, and the Groups panel
lets you manage groups. You can use the buttons in the center of the page to add and remove selected
users to and from groups.

10.6.1.1 Users

You can select the following user types:

User type Description

Admin Create and manage users and duplicate projects.

Standard Limited access and functionality in a project.
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User type Description

Read-Only Unable to make changes to a project even if you have other roles that would
otherwise allow it.

See User Access Overview for additional information.

10.6.1.2 Create single sign-on or password user

When creating a new user, the SSO On toggle lets you choose between creating a single sign-on (SSO)
user, or a user that logs in using their user name and password. The default setting is On. This cannot
be changed in edit mode.
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Add user

10.6 Step by Step 1 — Add user

1. Click the Add user icon in the Users panel.

The Create User dialog box opens.

2. Fill in the required fields indicated by an asterisk, and then click Save.

The SSO toggle lets you choose between creating an SSO user, or as a user that signs in with a user
name and password. To add a user that signs in with a user name and password, switch the SSO On
toggle to Off.
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Edit user

10.6 Step by Step 2 — Edit user

1. Select a user from the Users panel.

2. Click the Edit user icon at the top of the Users panel.

You can also right-click a user, and then select Edit User in the drop-down menu.

3. Make the updates in the dialog box, and then click Save.

The user name cannot be edited, and the SSO toggle cannot be changed in edit mode.

Activate user

To activate a user, right-click the user, and then select Activate User in the drop-down menu.

To see a list of deactivated users that you want to activate, enable the Show deactivated
Users toggle at the bottom of the Users and Groups panel.

Deactivate user

To deactivate a user, right-click the user, and then select Deactivate User in the drop-down menu. A
deactivated user can no longer access their account.

Reset a user's password (SSO off)

To reset a user's password, right-click the user, and then select Reset Password in the drop-down
menu. The user receives an email with instructions and a link to reset their password.

Set a user's temporary password (SSO off)

To set a temporary password for a user, right-click the user, and then select Set Temp Password in the
drop-down menu. A temporary password lets you manually set a new password for the user.

Delete a pending user

To delete a pending user right-click the user, and then select Delete User in the drop-down menu.

You can only delete pending users for non-SSO users.
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Resend activation email (SSO off)

To resend an activation email to a pending user, right-click the user, and then select Resend Account
Activation Email in the drop-down menu.

10.6.1.3 Groups

Groups are made up of multiple users. You can assign multiple users to projects using groups.

Add a group

To add a new group, click the Add group icon at the top of the Groups panel. In the dialog box enter a
group name, and then click Save.

Delete a group

To delete a group by right clicking a group, and then selecting Delete Group in the drop-down menu.

A group must unassigned to be deleted.

Rename a group

To change a group's name, right click a group, and then select Rename Group in the drop-down menu.

The new group name is shown in all historical data about the group.

10.6.2 Project permissions tab

The Project Permissions tab has two panels. You can add and remove selected users and Groups As
Teams using the center buttons.
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Item Description

1 Groups panel Shows groups and their users.

2 Projects panel Shows projects and the users and groups assigned to each
project. You can manage user and group access to a project

3 Add, Remove, and
Add Groups As
Team

You can use the buttons in the center of the page to add and
remove selected users and Groups As Teams to and from
projects.

Every user must be on a team but can only belong to a single team per project. Failure to
assign a user to a team for a given project will result in a misconfiguration error.

Best practice is to add Groups As Teams to projects instead of adding individual users.

Users and Groups As Teams have the following access types:

l Read Only – Unable to make changes to a project even if they have roles that would otherwise
allow it.

l Write - The default access given to a user or group.

If you used the Add button, you can then simply click the checkbox in the Team column.
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10.6.3 Export

You can export a Microsoft Excel file with user information and to which projects users are assigned to.
Export files are useful for audits.

To export, click Export in the top right of the page to download the file.
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